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System Information Page

This page is provided at the front of the manual to be an easy reference.  These are important
reference names and numbers that you will need when installing Kinnexus.  You should receive this
information during the first training session.  If you don’t know the answers to these questions, call
your board office.

System Administrator (SA)

SA Phone Number

Server Name

Server Phone

Server IP Address

Tech Support Number
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INTRODUCTION

Kinnexus is a progressive MLS system that utilizes the latest in computer
technology to provide a feature-rich program that is easy to use. Kinnexus
uses common Internet tools as well as specifically designed customizing tools
to give you all the power of the Internet combined with the power of a specific
application. With a completely new screen layout, basic features are quick,
intuitive, and convenient. But Kinnexus goes beyond just basic features. A full
feature form editor, Internet compatible email, data replication, relevancy
searching, and integrated mapping are all included in the standard Kinnexus
package.
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What you should know before reading this book
This book anticipates that you have had some previous experience with Windows. It does not describe
what a mouse is, or how to use one.  It does, however, include extra screen shots to help you know
where to click.  It also provides extra instructions that are normally associated with basic Windows
operation.  Keep in mind that this manual is not a Windows tutorial. If you are not comfortable with
Windows you should take some basic steps to improve your Windows skills. The more comfortable you
are with Windows, the more intuitive you will find Kinnexus.

A note from the author
Don’t you just hate manuals – especially computer manuals?  Me too. It always seems like the author
never addresses what I want to do or has a tendency to talk over my head.  Sometimes they do just the
opposite and talk in such basic language that the details aren’t discernible. I especially find it frustrating
when the author tells me what everything does without telling me what I should do. This manual has
been written with those concerns in mind.

This book is purposefully simple. If you are looking for detailed analysis of every Kinnexus function,
there are other books available. This is a “getting started” book, a beginning place. It is written to help
you get your feet wet in Kinnexus. This book will show you everything that you need to do for your
day-to-day routine, but it is by no means a description of everything that can be done in Kinnexus. More
information can be obtained in the Online Help, or in another manual.

How the book is organized
This book is organized into different sections, each representing a different group of functions.  Here is a
brief description of each section:

Getting Started
This section shows you how to install Kinnexus on your computer and walks you through connecting to
the server for the first time.  Most of the process is automated for your convenience.

Navigation
The first section in the manual will show you how to move around the program.  Understanding how the
program is laid out can greatly improve your productivity. Knowing where things are, and how to get
there are two of the most important steps when learning any program.

Searches
The Search section will show you how to create a basic search using Kinnexus.  With quick Search
Wizards you’ll be an expert detective in no time.

Columns
Search results are just one kind of data that is presented in columns.  Screens with columns in Kinnexus
are known as Listviews. This section will show you how to add, remove, and size columns, as well as
how to print the items you want.

Listings
This section shows you how to add and update listings.  Also in this section you are shown how to add
and update photos.  The data in Kinnexus is only as good as you make it.  This section will help you
keep your listings clean.
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CMA
Kinnexus is equipped with the tools to create a simple CMA.  An additional module is available to create a
CMA presentation package.  This section shows you how to use Kinnexus to create a simple CMA.

Internet
Kinnexus can take full advantage of the Internet. This section shows you how to use Kinnexus to browse the
Internet.  Another major part of the Internet is email. This section also shows you how to use Kinnexus to
send and receive Internet email via Kinnexus.

Appendices
Several appendices are available to provide you with quick reference material.

Other manuals available
As has been mentioned, this is only a “getting started” manual. Two other manuals are available for those of
you who would like to learn more about more advanced Kinnexus features.

Kinnexus for Advanced Users
This manual describes Kinnexus in more detail.  In this manual you will learn:

• Advanced navigation techniques that can speed your movement through Kinnexus
• Advanced listview functions that allow you to add or average columns to get totals or sub totals
• How relevancy searching can help you find the best matches  (Relevancy searching allows you to

categorize your search criteria from most important to least important.)
• Create your own custom flyers
• Create your own custom Search Wizards
• Create mail merges using Microsoft Word
• Send a listing through email
• Create custom Internet links and action items

Kinnexus Office Manual
This manual helps office administrators who need access to the entire office.  It details activities and func-
tions that will help you keep Kinnexus running smoothly for your office.  This manual shows you how to:

• Print your office inventory
• Move listings from agent to agent
• Add listings for other agents
• Determine office statistics
• Replicate data for an entire office

New features in Kinnexus 2.0
Kinnexus 2.0 has many features that were not available in the 1.x versions of Kinnexus.  For those of you
who have used the 1.x versions, here is a brief description of what you will find new in Kinnexus 2.0:

A New Look – Kinnexus 2.0 has a new look. Among other things, the Home Page buttons have been
moved onto tabs. The Home Page also has a new To Do List.

Searches – A new search method ensures you will have your results quickly, no matter how many results
were found.  As an added bonus, you can cancel a search in progress.
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Internet Email – Use Kinnexus to send Internet email anywhere in the world.  You can also attach listings or
search result lists to your email

Easier Setup and Installation – Kinnexus 2.0 is much easier to install and configure.  Answer a few questions
during the installation procedure and Kinnexus will take care of the rest.  You will only be alerted if there
is a conflict with another program.

Enhanced Printing – Kinnexus 2.0 supports various paper sizes from envelopes to poster size paper.
Easy Data Replication – Kinnexus 2.0 Replication Profiles take the mystery out of data replication.  Enhanced

connection routines minimize the chance of being disconnected.  And, if you happen to be disconnected
for whatever reason, simply reconnect and Kinnexus will continue from where it left off.
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SECTION 1

GETTING STARTED

This section describes several processes that will help you get started in Kinnexus. The first two
processes, Installation and Configuration, must be completed before you can begin your first
Kinnexus session. Once you have installed and configured Kinnexus, working in the program is
as easy as opening Kinnexus and logging on. Instructions on how to log on are also found in
this section.  Because searching is the feature you will be using most frequently in Kinnexus, an
additional chapter showing you how to do a quick, simple search has also been included.

This section is organized in the following way:

Chapter 1: Installation
Chapter 2: Configuration
Chapter 3: Logon
Chapter 4: Simple Search

*To complete several of the processes contained in this section,  you will need to consult your
Board Form. The Board Form provides information such as your user name, password, server
name, etc., that you will need to install, configure, and log on to Kinnexus.



6 Section 1 - Getting Started

INSTALLATION
This chapter will show you how to install the Kinnexus database and software
on your computer.

*The instructions in this chapter are meant to help you start using Kinnexus quickly. For a
more detailed description of the installation process and options, see Appendix A at the back
of this manual.

System Requirements for Kinnexus
To install Kinnexus, you will need the following hardware and software:

• Kinnexus 2.0 CD
• Windows 95 or Windows 98
• 16 MB or more of RAM
• 50 MB free hard disk space
• 486 processor
• VGA monitor
• 14.4 Kbaud

Installing Kinnexus
The following instructions will show you how to install Kinnexus. A wizard
will help you through the installation process. When instructed, consult your
Board Form for information about certain fields.

1. Close any open programs on your computer.

2. Insert the Kinnexus CD into the CD-ROM drive of your computer. The
Kinnexus Setup screen will appear.

3. On the Setup screen, click Kinnexus.
Note:At this point some Windows software may need to be installed on your computer.
If this is the case a series of dialog boxes will flash on the screen after you click
Kinnexus. If any screens with an OK button appear, click the OK button and the
installation will continue. When the Windows software installation is complete you will
have to restart your computer and begin the installation process again. You will only
have to install Windows software once.

C H A P T E R

1

Figure 1.1 - The Setup screen.
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Figure 1.2 - The Installation Wizard.

Figure 1.4 -The Directory screen.

Figure 1.5 -The Features screen.

Figure 1.6 -The Installation screen.

Figure 1.3 - The Next button.

Figure 1.7 - The Go button.

4. The Installation Wizard appears. Click the Next button.

5. The Directory screen appears. Click the Next button.

6. The Features screen appears. On the Features screen, click in the check boxes that are
selected on the Board Form next to Kinnexus Features.

7. After selecting the appropriate features, click the Next button.

8. The Installation screen appears. To install Kinnexus, click the Go button at the top of the
screen.
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9. Kinnexus will install. A dialog box will appear asking you if you wish to restart Win-
dows. Click the Yes button.

Windows will restart. When you reopen Kinnexus, you will be prompted to configure
Kinnexus before you begin your session. See Chapter 2 for instructions on how to config-
ure.
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CONFIGURATION
Once you have installed Kinnexus on your computer, you will need to
configure the program by setting up your user profile and specifying what
kind of connection to the Kinnexus database you use.  You will only have
to configure Kinnexus once. After that, you can simply open Kinnexus,
log on, and go to work.

*The instructions in this chapter are meant to help you start using Kinnexus quickly. For
a more detailed description of the configuration process and options, see Appendix B at
the back of this manual.

Configuring  Kinnexus
The following instructions will take you through the basic steps of con-
figuration. When instructed, consult your Board Form for information
about certain fields.

Logon Screen

1. Open Kinnexus by double-clicking the Kinnexus icon on your
desktop, or by clicking Start>Program>Kinnexus 2.0. The Logon
screen will appear.

2. Find the name next to Username on the Board Form and type it into
the Username field on the screen.

3. Find the word next to Password on the Board Form and type it into
the Password field on the screen.

C H A P T E R

2

Figure2.1  - The Logon Screen.

Figure 2.2 - The Username field.

Figure 2.3 - The Password field.
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4. Click in the Save Password check box. A check mark will display in the check box.

5. Click the Next button at the top of the screen.

Welcome to Kinnexus Screen
Note: If someone has logged onto your computer before, it is possible that some of the fields on this screen
already contain information. If the information on your Board Form corresponds to the information in the fields,
simply click the Next button. Change any incorrect information to reflect the information on your Board Form.

The Welcome to Kinnexus screen will appear. Proceed to the Welcome to Kinnexus
Screen section.

1.  Find the word(s) next to Description on the Board Form and type them into the Descrip-
tion field on the screen.

2. Find the name next to Server Name on the Board Form and type it in the Server Name
field on the screen.

3. Find the name next to Database Name on the Board Form and type it into the Database
Name field on the screen.

Figure 2.4 - The Save Password checkbox.

Figure 2.5 - The Next button.

Figure 2.6 - The Welcome to Kinnexus screen.

Figure 2.7 - The Description field.

Figure 2.8 - The Server Name field.

Figure 2.9 - The Database Name field.
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4. Find the numbers next to Server IP address on the Board Form and type them into the
Server IP address field on the screen. If there is no number next to Server IP Address on
the Board Form, leave the Server IP address field on the screen blank.

5. Find the Dial into server checkbox on the Board Form. If Dial into server is checked on
the Board Form, click in the Dial into server field on the screen. A check mark will
appear in the box.

6. Find the numbers next to Phone Number on the Board Form and type them into the
Phone Number field on the screen.

7. Click the Next button.

The Download Profiles screen will appear. Proceed to the Download Profiles Screen

section.

Download Profiles Screen
Note: If someone has logged onto your computer before, it is possible that some of the fields on this screen
already contain information. If the information on your Board Form corresponds to the information in the fields,
simply click the Next button. Change any incorrect information to reflect the information on your Board Form.

Figure 2.10 - The Server IP address field.

Figure 2.11 - The Dial into server checkbox.

Figure 2.13 - The Next button.

Figure 2.14 - The Download Profiles
screen.

Figure 2.12 - The Phone Number field.
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1. Make sure there is a small black dot in the cirlce next to Use Kinnexus online only. Do

not download any information.

2. Click the Next button at the top of the screen.

The Online Database screen will appear. Proceed to the Online Database Screen section.

Online Database Screen
Note: If someone has logged onto your computer before, it is possible that some of the fields on this screen
already contain information. If the information on your Board Form corresponds to the information in the fields,
simply click the Next button. Change any incorrect information to reflect the information on your Board Form.

1. Find the phrase next to Server Database on the Board Form, and click in the matching
circle on the screen.

2. Click the Next button at the top of the screen.

          The Progress screen will appear. Proceed to the Progress Screen section.

Figure 2.16 - The Next button.

Figure 2.17 - The Online Database Screen.

Figure 2.18 - Server Database options.

Figure 2.19 - The Next button.

Figure 2.15 - The Use Kinnexus
online only radio button.



Chapter 2 - Configuration 13

Progress Screen

1. Click the Go button to begin configuration. (The check boxes in the Progress window
will check off as they are configured.)

Congratulations, you have finished configuring Kinnexus and can now begin your first
Kinnexus session! From now on when you want to use Kinnexus, all you have to do is open
the program, log on, and go right to work. If you are ready to run your first search, see
Chapter 4.

Note: If you have Kinnexus software that needs updating, a series of small screens will flash on the screen
after you click the Go button. If any screens with an OK button appear, click the OK button and the update
will continue. When the update is complete, Kinnexus will close and reopen at the Logon screen. See
Chapter 3 to learn how to Logon

Figure 2.20 - The Progress screen.

Figure 2.21 - The Go button.
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C H A P T E R

3
LOGON

Once Kinnexus has been installed and configured, all you have to do to
access Kinnexus is open the program and log on. Logging on authorizes
you to use Kinnexus and brings up your settings, such as portfolios, saved
searches, and email.

*The instructions in this chapter are meant to help you start using Kinnexus quickly. For a
more detailed description of the logon process and options, see Appendix C at the back of
this manual.

Logging on to Kinnexus
The following instructions will show you how to log on to Kinnexus. You
will be prompted to log on every time you begin a Kinnexus session. When
instructed, consult your Board Form for information about certain fields.

1. Open Kinnexus by double-clicking the Kinnexus icon on your desk-
top, or by clicking Start>Program>Kinnexus 2.0. The Logon screen
will appear.

2. If your username is not in the Username field, find the name next to
Username on the Board Form, and type it into the Username field on
the screen.

3. If your password is not in the Password field, find the word next to
Password on the Board Form and type it into the Password field on
the screen.

4. Click in the Save password check box. (It might already be selected.
In that case, leave it selected.)

Figure 3.1 - The Logon screen.

Figure 3.2 - The Username field.

Figure 3.3 - The Password field.

Figure 3.4 - The Save Password check box.
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5. The name in the System field should be the name you entered during configuration.
Leave this name as the default. If you use more than one system, see Appendix C.

6. When you are ready to begin your Kinnexus session, click the Go button.

You can now begin your Kinnexus session! See Chapter 4 for instructions on how to
run a simple search.

Figure 3.5 - The Go button.
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C H A P T E R

                    4SIMPLE SEARCH
In this chapter you will learn the basics of  creating a simple search. For
information about more complicated searches, please see Section 3 of this
manual, which contains six chapters related to searching, including a tutorial.

Because of the customizable nature of Kinnexus, it is impossible to include
graphics that exactly correspond to the screens you see.  Don’t panic if some-
thing you see in the manual looks different or is in a different place than you
see on the screen.  This just means that your system administrator has custom-
ized it. The basic structure is probably the same.

Searching

1. Start this tutorial from the Home Page. If you are not at the Home Page,

click the Home button in the top-right corner of the screen.

2. Click the Favorites tab at the left of the screen.

3. Click the Residential Quick Search icon.

4. The Search Wizard appears.  Using the Search Wizard is the quickest
way to start a temporary residential search.

Figure 4.1 - The Home button.

Figure 4.2 - The Residential Quick Search icon.

Figure 4.3 - The Search Wizard.
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5. Click in the Price field on the first page of the Search Wizard.  Notice that a blinking
line is now in the box.

Note: The following instructions and graphics assume that you have only one field next to search items
dealing with ranges.  It is possible that your system administrator has chosen to display fields dealing with
ranges, such as Price and Bedrooms, as two fields side-by-side. If you come across a search item dealing
with ranges that has two fields side-by-side, enter the minimum value in the left field, and the maximum
value in the right field.

6. In the Price field, type: <200000-250000>.  This is the price range for the search. You
don’t have to type the comma.

7. Find the Status list box.  Click in the Active check box. A check mark appears in the
check box.

8. Click the Go button at the top of the wizard.  This starts the search. You are taken to a
list of search results.

A list of search results matching the criteria your entered will display. See Section 3 of this
manual for more in-depth information about searching.

Figure 4.4 - The Price field.

Figure 4.5 - The Price field containing a minimum and maximum value.

Figure 4.6 - The Status list box and Active check box.

Figure 4.7 - The Go button.
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SECTION 2

BASIC NAVIGATION

Now that you have installed Kinnexus and successfully connected to the server, you are ready
to become familiar with the Kinnexus program. This section of the manual will introduce you to
the basic organization of Kinnexus and the different features of the Kinnexus screen . You will
also learn how to move between the different parts of the program.

This section is organized in the following way:

Chapter 5: The User Interface
Chapter 6: Navigating Kinnexus
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This chapter will acquaint you with Kinnexus screen features, and begin to show you how
they work.  You will also get an idea of how versatile Kinnexus is by learning to turn parts
of the screen on and off.

Parts of the screen
The following instructions assume you are looking at the Home Page. The Home Page is
the screen you see after logging on to Kinnexus. (If you need help logging on, please refer
to Chapter 3.)  The Home Page is one of two basic screens you will encounter in Kinnexus.
The second screen, called the Hot Sheet, will be discussed later in this chapter.  Some parts
of the screen are optional, meaning they can be turned on and off.  Figure 5.1 below shows
all of the items turned on so you can see what they look like.

Home Page
The Home Page is the screen you see right after logging in.  The Home Page is a convenient
place to start most functions in Kinnexus.

System Message
Your system administrator can send a message to the entire MLS.  This message appears on
the Home Page.  This is a convenient place for your system administrator to inform you
about upcoming events, or relay concerns and general help.

Main Window
The Main window is the large window in the middle of the screen.  The information in this
window changes depending on where you are in the program.  When you first log on, it
displays the message from the system administrator.  In other areas of the program, it shows
the search forms, search results, photos, or listing entry forms.

C H A P T E R

5USER INTERFACE

System Trays

Navigator
Window

Menu

To Do List

System
Message

Banner Ad

Figure .1 - The Home Page.
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To Do List
The To Do List has a list of things that you will probably want to do each day.  It informs you of listings that are
about to expire, of new mail messages, and of any new results for your saved searches.  It also can provide easy
access to the Hot Sheet or web pages.  For more information regarding the To Do List, see page 27.

Figure 5.2 - The To Do List.

Navigator window
The Navigator window is an advanced way to move around Kinnexus.  It functions much like Windows Explorer.
It is not recommended that you use the Navigator window unless you are very comfortable with using Windows
Explorer. If the Navigator window is visible and you would like to turn it off, see page 24.

Figure 5.3 - The Navigator Window.

System Trays
The System Trays divide different parts of the program into different task bars   These task bars contain com-
mands grouped by functions. Clicking one of the tray names opens the tray.

Figure 5.4 - The Task Bar or System Trays.

Menu Bar
A Menu bar is standard to most Windows programs.  Clicking a menu on the Menu bar will display a menu of
options you can select.  File, Edit, and View are some of the menus on the Menu bar.

Figure 5.5 - The Menu Bar.
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Banner Ad
Your system administrator can use this space to place ads from local companies, or links to websites. The banner
ads appear one at a time at the top of the Home Page, and rotate however often the system administrator dictates.

    Hot Sheet
             The Hot Sheet screen has functionalities not available from the Home Page. To view these functionalities, click

Hot Sheet Entries in the To Do List.

Field Chooser
The Field Chooser is used to add fields from the database to listviews or forms.  You can turn the Field Chooser
on or off.  If the Field Chooser is turned on, it is still only visible when you are looking at a listview or a form –
the places where the Field Chooser is useful.

Next Step Bar
The Next Step Bar is another way to move around Kinnexus.  Buttons on the left side of the bar let you know
what you can do next.  Buttons on the right side of the bar show where you can go next.  As you move around the
program, the buttons on the Next Step Bar change to reflect the different possibilities of your new location.  The
Next Step Bar is a powerful tool for both amateur and expert users alike.  The Next Step Bar is not available from
the Home Page. (See Figure 5.8)

Figure 5.6 - The Hot Sheet Page.

Figure 5.7 - The Field Chooser.
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Current Form Indicator
The Current Form Indicator is the name of the report or view currently in the Main window.  This Current Form
Indicator can be found at the top-center of the toolbar. (See Figure 5.9) Clicking the Current Form Indicator
reveals a list of other views or forms that can also be used to show the data.

Zoom
Zooming is a way to change the screen size of forms and listviews.  Click the Zoom Out “ + ” button to make the
text larger, or the Zoom In “ - ” button to make the text smaller. You can also click the percentage between the
two Zoom buttons and select the desired zoom from the pop-up menu that appears.

Save button
The Save button looks like a computer disk, and is a quick and convenient way to save the information that is
currently in the Main window.   Clicking this button is the same as clicking File<Save.

Print button
The Print button looks like a printer and is a quick and convenient way to print whatever is in the Main window.
Kinnexus automatically uses your default Windows printer, but allows you to designate another printer.  If you
can print from Windows, you should be able to print from Kinnexus.

Send button
The Send button looks like an envelope. It is a convenient way to send whatever is in the Main window to
another person using email.

Connect button
The Connect button is a convenient way to connect to the server.  Clicking the Connect button will link your
computer to the Kinnexus server.  You can configure Kinnexus to dial the server directly, or to dial your Internet
provider.  The Connect button is to the right of the Send button.

Figure 5.8 -The Next Step Bar

Figure 5.9 -The Current Form indicator.

Figure 5.10 -The Zoom indicator.

Figure 5.11 -The Save button.

Figure 5.12 - The Print button.

Figure 5.13 - The Send button.

Figure 5.14 - The Connect button.
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View Highlighters button
The View Highlighters button lets you group or mark listings.  This button allows you to hide listings that
have been flagged in a particular color.  This button looks like a small marker and is to the right of the
Connect button.

Highlighter Selection button
 Clicking the Highlighter Selection button reveals a list of highlighter colors you can choose.  Use
highlighters to flag listings in which you think your buyers may be interested, lists that they have already
seen, or perhaps those lists  in which you know they are not interested. There are several colors to choose
from -- use them however you wish.

Back button
The Back button returns you to the last page you were viewing.  It works exactly like a Back button on a
Web browser.  The Back button turns yellow when there is a page to return to, and turns gray when there
is not a page to return to.

Next button
The Next button takes you to the next screen. The Next button is yellow when there is a page to return to,
and is gray when there is not a page to return to. The Next button works like a Next button in a web
browser.

Cancel button
The Cancel button to stops the current action.  This command is especially helpful when you want to
terminate a search that may be returning lots of results, and you don’t want to wait for the results to load.

Home button
The Home button always returns you to the Home Page.  If you are ever lost, confused, or don’t know
what to do next, go to the Home Page.  The Home Page is also a convenient place to start every Kinnexus
function.

Figure 5.15 - The Highlighters button.

Figure 5.16 - The Highlighter Selection button.

Figure 5.17 - The Back button.

Figure 5.18 - The Next button.

Figure 5.19 The Cancel button.

Figure 5.20 - Home button.
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Turning things on and off
Many items on the Kinnexus screen can be turned on or off.  This helps you customize the Kinnexus
interface to your comfort level.  New users, for example, may prefer an interface that hides many of the
technical details, whereas an advanced user may want to see those details.

Your system administrator has pre-configured Kinnexus to appear how he/she feels it will be easiest for a
new Kinnexus user.  If you would like to change the way Kinnexus appears when you start Kinnexus, see
Your Configuration on page 25.

The View menu on the Menu bar determines which toolbars and windows are visible.  Click the View
menu.  The following list appears:

A check mark next to an item means that the window or toolbar is visible, or will be visible when you are
looking at the appropriate screen.  Clicking an item in this menu turns the check mark on and off.

Try this…
1. If you are not looking at the Home Page, click the Home button at the top-right corner of the screen.

2. Click the View menu.  The View pop-up menu appears.
3. Check to see if Navigator has a check mark next to it.  (It probably doesn’t.)

4. Click Navigator.  The Navigator window will appear.

Figure 5.21 - The View menu is used to turn screen parts on and off.

Figure 5.22 - The View menu without a check mark next to Navigator .



5. Click the View menu again.  Notice that Navigator now has a check mark next to it. This means that
the Navigator window is enabled.

6. Click Navigator again. The menu and the Navigator window disappear.

Your configuration
Each time you log in to Kinnexus, your screen settings will return to the default settings configured by your
system administrator.  A “configuration” contains information about which parts of the screen are on or off.

Examine your configuration
It is possible that the system administrator has created more than one configuration to use.  The following steps
will introduce you to the various available configurations:

1. Click  Tools > Configuration. The User Configuration Management dialog box appears.

2. The User Configuration Management dialog box shows a list of all the configurations that you have
created, or that are available to you.  In Figure 5.25, there is only one configuration available.

Figure 5.23 - The View menu with a check mark next to Navigator.

Figure 1.24 -Selecting Tools > Configuration.

Figure 5.25 -User Configuration Management dialog
box showing  one available configuration .
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From the User Configuration Management dialog box, you can click another configuration if one is avail-
able, or click the Properties button to view the details of your particular configuration.

The brief reference to configuration in this manual has been made so that you will know where to start, and
where to get more information. The Kinnexus for Advanced Users manual covers configuration in greater
detail.

What’s Next?
In the next chapter you will learn how to move from place to place in Kinnexus.
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C H A P T E R

6
NAVIGATING KINNEXUS

Now that you are familiar with the different parts of the screen, you are ready to move
about the program. This chapter will show you two different ways to move through
Kinnexus: the To Do List and System Trays.

The To Do List
When designing Kinnexus, we realized that most Realtors would simply like a button in
the middle of the screen that said, “Predict everything I want to do today and just do it.”
Then, to be really fancy, we would pre-click the button for you.  While that is not quite
possible right now, the To Do List is a pretty close approximation of what we think you
will want to do every day.

The To Do List appears on the right side of the Home Page.  It contains a list of common
functions, like checking the Hot Sheet, checking new email, and checking updates on
saved searches.  When you click an item, Kinnexus takes you to the corresponding place
in Kinnexus where you can manage that particular list item. Clicking the Hot Sheet
Entries line, for example, takes you to a list of properties that have changed in the last few
days.  After you click an entry, a check mark appears next to the item. Clicking an item a
second time removes the check mark.

The following features are maintained in the To Do List:

? Hot Sheet Entries – Frequent listing updates.  Clicking Hot Sheet Entries displays
a listview of new and modified listings.  Your system administrator controls how
often the Hot Sheet Entries are updated.

? Email messages – The number of new email messages you have in your inbox.
? Expiring listings – Listings that are going to expire soon.
? Saved searches – All of your saved searches.  This feature allows you to easily

check the searches for new search results.
? Internet links – Items that remind you to check web pages.  You can also specify

how often the item should appear in your To Do List.  Clicking on the Internet
items in the To Do List opens the appropriate web page.

Figure 6.1 - A check mark appears
next to items you have already visited.
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Navigate Using the To Do List
Here are some simple instructions showing you how easy it is to use the To Do List to navigate Kinnexus.

Check the Hot Sheet Entries
1. Locate Hot Sheet Entries on the To Do List.  It will be preceded by a number representing the number of

listings on the Hot Sheet. Click Hot Sheet Entries.

2. The Hot Sheet is displayed.  The Hot Sheet looks like this:

3. Click the Home button in the top-right corner to return to the Home Page.

4. Notice that Hot Sheet Entries now has a check mark by it, as shown in figure 6.5.

Figure 6.2 - Clicking Hot Sheet Entries
moves you directly to the Hot Sheet.

Figure 6.3 - The Hot Sheet.

Figure 6.4 - The Home button.
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Check a Saved Search
Kinnexus allows you to easily check your saved searches to see any search results that have changed.

1. Click the name of a saved search in the To Do List.

2. You are taken to the search result list for that search.  New search results are displayed in red.

3. Click the Home button at the top-right corner of the screen to return to the Home Page.

Summary
The To Do List is a convenient way to move through Kinnexus. One click takes you directly where you need to
go.  The To Do List tracks the Hot Sheet, saved searches, expiring listings, new email, and any web pages you
want to monitor.  If you are interested in adding and modifying items in your To Do List, consult the Kinnexus
for Advanced Users manual.

Figure 6.5 -  A check mark displays next to Hot Sheet
Entries once you have viewed the day’s hot sheet.

Figure 6.8 - The Home button.

Figure 6.7 - New search results are displayed in red.

Figure 6.6 - Using the To Do List to check an existing search.
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System Trays
Another way to move around Kinnexus is to use System Trays.  System Trays, unlike the To Do List, allow
you to access any part of the program. System Trays separate all of the Kinnexus functions into individual
groups based on their function.  The Listing tray, for example, has all of the functions and tools that are
relevant to maintaining your listing inventory.  The Search tray has all of the functions for creating searches
and viewing search results.  System Trays are located on the left side of the Home Page.  This is what they
look like:

Changing System Trays
Clicking the name of the different System Trays exposes another set of commands.  Figure 6.9 shows a
typical Favorites tray.  Clicking the Search tray displays the Search icons.

Figure 6.9 - The System Trays showing the Favorites tray.

Figure 6.10 - The System Trays showing the Search tray.
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Scrolling System Trays
Sometimes there are too many commands in a System Tray to show all of them on the screen at the same
time.  When there are more commands in a tray than can be shown on the screen at once, Kinnexus puts
yellow Scrolling Arrows at the top and bottom of the System Tray. Clicking directly on a Scrolling Arrow
will scroll all of the icons in the tray, allowing you to see the hidden commands.

Favorites Tray
The Favorites tray is the only customizable System Tray.  You can put the commands you use most often in
the Favorites tray to save time finding the command in the other System Trays. For convenience, your
system administrator has predetermined the commands that he/she thinks you will use most frequently.
Documentation for changing the commands in the Favorites tray is provided in the Kinnexus for Advanced
Users manual.

Figure 6.11 - The yellow Scrolling Arrow at the bottom of the task bar means
there are extra commands in the tray.  Click the Scrolling Arrow to scroll the
commands.
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SECTION 3

SEARCHING

Searching is probably the process that you will be using the most in the Kinexus
program.  This section explains all the basic points you need to know to search.  Section
3 begins with an overview of searches and explains the basic parts of the screen that are
used when performing a search. Next, you will be shown how to search by field type,
such as numbers, words, or list items. Then you will be shown how to navigate search
results.  The last chapter in this section is a tutorial, where you will be guided step by
step through different searching features.

This section contains the following chapters:

Chapter 7: Basic Searches
Chapter 8: Saved Searches
Chapter 9: Search Results
Chapter 10: Search Tutorial
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BASIC SEARCHES

Searching in Kinnexus is extremely flexible.  On one hand, it has been designed so you
can get in and get what you want quickly, yet it is powerful enough to allow you to
search on most every field in the database.  In this chapter you will learn the basics of
creating a search.

Because of the customizable nature of Kinnexus, it is impossible to include screen
shots that exactly correspond to the screens you see.  Don’t panic if something you see
in the manual looks different or is in a different place than you see on the screen.  That
just means that your system administrator has customized it. The basic structure is
probably the same.

Search overview
There are four different parts to a search:

• The Search Wizard
• The Criteria Form
• The Search Result List
• The Search Result Form

The Search Wizard
Your system administrator creates and maintains the Search Wizards.  A Search
Wizard is a very intuitive way to search the database because of the graphical layout.
The Next and Previous buttons move you between the different pages.  System
administrators place the most commonly searched fields on the first pages of a
SearchWizard.

There are five buttons at the top of a Search Wizard.

C H A P T E R
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Figure 7.1 - The Search Wizard is used to define searches.

Figure 7.2 - Buttons on the Search Wizard.
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The Search Criteria Form
The Search Criteria Form is another way to enter search criteria.  The form is laid out on the monitor exactly as
it would look if you sent it to a printer. Search criteria is entered into fields. Use the TAB key to move forward
through the fields.  SHIFT + TAB moves backwards through the fields. From the Search Criteria Form you
can either run the search, or reopen the Search Wizard. The Go button on the Next Step Bar starts the search.
For more information about entering a search from the Search Criteria Form, see page 44.

The Search Result List
After running a search you are shown a list of search results.  The proper name for this list is a Listview.
Listviews are a convenient way to view and organize search results.  You can, for instance, sort the list
based on any one of the columns. From this list you can return to the Search Criteria Form, the Search
Wizard, or view more detailed information about any one of the search results.  To print from this list,
choose File<Print. For more information about Listviews, see page 51.

Search Wizard Buttons

Cancel
This button cancels the search wizard without performing
the search.  You can also click the cancel button to stop a
search you have started.

Previous This button returns you to a previous page in the search
wizard.

Next This button takes you to the next page in the search
wizard.

Go To
Criteria

This button drops you out of the search wizard to the
search criteria page without executing the search.  Any
information you have already entered in the search wizard
will also be entered on the criteria form.

Go

The Go button starts the search process. You can click on
this button from any page in the search wizard.  You don't
need to go all the way to the end of the wizard. In fact, you
should be able to enter most of your searches from the
first or second page of the search wizard.

Figure 7.4 - A Search Criteria Form.

Figure 7.3 - Description of the Search Wizard buttons.
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The Search Result Form
Search Result Forms show more detailed search results.  You can select what type of form you would like to use,
depending on the situation.  Perhaps you would like only a flyer – something with a large photo and an overview
of the property.  Or, perhaps you would like a more detailed page that has every field the listing agent has
specified about the property.  Search Result Forms can be created by anyone – including you.  If none of the
existing forms suit your needs, you can create your own.  You can create a form that prints on a large poster-sized
piece of paper, or create a form that prints addresses on an envelope.  All of this and more is possible with
Kinnexus Search Result Forms.  For more information about Search Result Forms, see Chapter 9 of this manual.

Now that you know the basics of running a search, here are a few other searches you can try that will show you
how to search the different types of data:

Figure 7.5 - A Listview of search results.

Figure 7.6 - A sample Search Result Form.
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Search on price and bedrooms (Numbers)

Probably one of the most common searches you will use is one that restricts the price of and the number of
bedrooms in a residential property.  If you specialize in an area other than residential, such as land or commercial,
you can substitute the Bedroom field with something more applicable -- such as square feet or acreage.  This
example will show you how to search number fields in Kinnexus:

Beforehand
• These instructions start from the Home Page.  If you are not on the Home Page, click the Home button in

the top-right corner of the screen.

What to do

1. From the Home Page, click the Search tray in the task bar at the left side of the screen.

2. Click the Residential Quick Search icon.  The Search Wizard appears.

3. Find the Price field.  Although the wizards look different for each board, there should be a Price field on
the first page. Find the Price field and click in it.

         Note:
The following instructions and graphics assume that you have only one field next to search items dealing
with ranges.  It is possible that your system administrator has chosen to display fields dealing with ranges,
such as Price and Bedrooms, as two fields side-by-side. If you come across a search item dealing with
ranges that has two fields side-by-side, enter the minimum value in the left field, and the maximum value in
the right field.

4. In the Price field, type: <130000>.  This is the minimum value.  You don’t need to enter a dollar sign or
commas.  Kinnexus will do it for you.

Figure 7.7 - The Home button.

Figure 7.8 - The Search system tray.

Figure 7.9 - The Residential Quick Search icon.

Figure 7.10 - The Price field on a Search Wizard.

Figure 7.11 - The Price field containing a mimimum value.
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5. Type a dash: <-> next to the value you entered in step 4.

6. Type: <140000> after the dash. This number is the maximum price for the search.

7. Click in the Bedroom field on the wizard.  Enter: <3-4>.

8. Run the search by clicking the Go button at the top of the wizard.  You are taken to a list of search
results.

9. To go back and modify the search, click the Criteria Wizard button on the Next Step Bar.

Note:
The above example assumes that both Price and Bedrooms fields were on the first page of the wizard.
However, these fields might not be on the Search Wizard at all.  The location of fields on the Search Wizard
is determined by the local system administrator.

To get this Enter this Additional Information

All properties with price
between $120,000 and
$140,000.

You don’t need to enter the
dollar sign and commas.
Kinnexus adds them
automatically.

All properties less than
$120,000

This search actually finds all
properties less than or
equal to $120,000.

All properties more than
$120000

Figure 7.17 - Methods of entering number ranges.

Figure 7.16 - The Criteria Wizard button returns you to the Search Wizard.

Figure 7.15 - The Go button starts a search

Figure 7.14 - The Bedroom field containing a minimum and maximum
value.

Figure 7.13- The Price field containing a maximum value.

Figure 7.12 - A dash next to the mimimum value indicating a range.
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Search on street name (Text)
These instructions will show you how to find a property on a particular street.  Street names are text fields.
Text fields can be tricky because you are dependent on the listing agent to type them in correctly.  It is best
when searching text to use only a portion of the word you are looking for, and to place the wild card charac-
ter * before and after the text.

For this example you are going to find all of the property on Martin Luther King.  (If your city or town
doesn’t have a street called Martin Luther King, just substitute in a street name you are familiar with.)  You
don’t know if the listing agent typed the name of the street ML King, Martin L King, ML King Ave. or ML
King Avenue.  That is why you use wild cards when searching text.  Follow these steps:

What to do?

1. From the Home Page, click the Search tab in the task bar on the left side of the screen.

2. Click the Residential Search Quick icon.  The Search Wizard appears.

3. Find the Street Name field.  You may need to advance to the second page to find it.  To advance to
the second page click the yellow Next button at the top of the wizard.  The Next button looks like an
arrow pointing right.  Only click the Next button if you don’t see the Street Name field on the current
page of the Search Wizard.  Keep clicking Next until you see the Street Name field.

4. Click in the Street Name field.  Type: <*king*>

5. Run the search by clicking the Go button at the top of the wizard.  You are taken to a list of search
results.  If one of your result columns is Street Name, you will notice that all of the properties have
“king” somewhere in their name.  ML King, Martin L. King are possible search results, as well as
Buckingham or Kingston.

6. If you wish to modify the search, click the Criteria Wizard button. This will bring up a form that will
allow you to modify the search.

Figure 7.18 - The Search tab.

Figure 7.19 - The Residential Search Quick icon.

Figure 7.20 - The Next button takes you to the next wizard page.

Figure 7.21 - The Criteria Wizard button.
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Note:
A similar search could be run on any text field.  Other text field examples are Agent Name, Subdivision, Remarks,
and City.  Remember to use asterisks on either side of the text you are searching for.

Search on status (List Boxes)
The following example will show you how to search for a particular status.  The Status field in Kinnexus is a list
box. The process of searching for a particular status is the same for all list boxes.

What to do

1. From the Home Page, click the Search tab at the left side of the screen.

2. Click the Residential Quick Search icon.  The Search Wizard appears.

3. The Status list box is probably on the first page of the wizard.  (If it is not, continue clicking the Next
button until you see it.) Click in the Active check box. You will see a check mark appear in the box.
Remove the check mark by clicking in the box again. Click all the items in the Status list box that you
want. Remember, however, that the more items you select, the fewer results you will receive.

4. To narrow the search a little you may want to enter a price range in as well.  This is only to limit the
number of search results and is not necessary.  If you don’t enter any other criteria you will find all active
listings in the MLS. That might take a while to complete.

5. Run the search by clicking the Go button at the top of the wizard.  You are taken to a list of search results.

6. If you want to go back and modify the search click on the Edit Criteria button.

Figure 7.22 - The Search tab.

Figure 7.23 - The Residential Quick Search icon.

Figure 7.24 - A check mark appears next to the selected statuses.

Figure 7.25 - The Go button.

Figure 7.26 - The Edit Criteria button.
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Search on swimming pool (Features)
This example will show you how to search for a particular feature.  Because the items included in the Search
Wizard are entirely determined by your system administrator, there is no guarantee you will have a Feature
List in your Search Wizard.  If a Feature List is not available, you should skip to the chapter Search for
fields not on the Search Wizard, page 44.

Kinnexus allows you to search for properties that have or do not have a particular feature.  For instance,
Kinnexus will let you search for properties that have a swimming pool.  It will also let you search for all
the properties that do NOT have a swimming pool.  You can search on as many items as you want, but it is
suggested that you limit your search to just a couple of items, otherwise you might get zero results.

A Feature Group looks like a list box.

The boxes can be empty, or have a check mark, or an ‘X’.  Here is what the marks represent:

The following instructions will show you how to find properties with a swimming pool.  If you do not
have a swimming pool feature in your database, or if the feature is not on the Search Wizard, you can use
another feature field or refer to page 44.

Feature Check Boxes

An empty box with no mark signifies that you are not searching on that particular
feature.  You don’t care whether a search result has that feature or not.

A check mark means that you are interested in properties with that feature.  All search
results will have that feature.

Placing an ‘X’ in a box means you are only interested in properties without that feature.
All search results are guaranteed not to have that feature

Figure 7.28 - Description of search Feature Group check marks.

Figure 7.27 - A Feature List box.
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Sample feature search

1. From the Home Page, click the Search tab at the left side of the screen.

2. Click the Residential Quick Search icon.  The Search Wizard appears.

3. Find the Swimming Pool check box.  It may or may not be on a Search Wizard.  If it is not, find
another feature field to search, or see Searching on Anything, page 44.  Once you find a feature to
search, put a check mark next to the desired feature by clicking in the box.

4. To narrow the search a little, you may want to enter a price range in as well.  This is only to limit
the number of search results and is not necessary.

5. Narrow the search further by searching only the active listings.  Click in the Active check box.

5. Run the search by clicking the Go button at the top of the wizard.  You are taken to a list of search
results.

6. If you want to modify the search, click the Criteria Wizard button.

Figure 7.29 - The Search tab.

Figure 7.30 - Residential Quick Search icon.

Figure 7.31 - Swimming pool check box.

Figure 7.32 - Active check box.

Figure 7.33 - The Go button

Figure 7.34 - The Criteria Wizard button.
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Search on dates
This example will show you how to create a Hot Sheet by hand.  Through this example you will learn how to
search on dates. This example will find all of the properties that were modified yesterday.

There are several date fields in Kinnexus.  One of the available fields is called the Last Mod, or last
modified date.  Any time a listing is changed or otherwise updated, the Last Mod date is set to the current
date.  This is the field you are going to use for this search.  Below are some of the other date fields in
Kinnexus.  Your particular MLS may or may not use all of these fields, and others might have been created.

There are several ways to search dates.  Here is a list of some of the different ways:

Listing Date Fields

Listing Date The date the listing agreement was signed.

Creation Date The date the listing was entered into Kinnexus.

Activation Date The date the "Activate" button was pressed in Kinnexus.

Contract Date The date the listing went under contract.

Sold Date The date the sale was closed.

Expiration Date The date the listing expires.

Format For Date Searches
To Get This Enter This Additional Information

December 1-15, 1999 12/1/99 - 12/15/99

December 1-15, 1999 Dec 1, 1999 - Dec 15, 1999

December 1-15, 1999 12/1 - 12/15
If you don't specify a year,
Kinnexus assumes the
current year.

Any date in the last 3
days

Current -3d

D = Days
W = Weeks
M = Months
Y = Years

Any date in the past 2
weeks Current -2w

You can also use the plus (+)
symbol to check dates in the
future.  This is helpful for
open houses.

Figure 7.35 - Kinnexus date fields. Your database may have additional date fields.

Figure 7.36 - Examples of searching formats.
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Dates after year 2000
The same date formatting applies for years after 2000. This means that the year 2000 can be entered as 2000, 00,
or just left blank assuming the current year is 2000. When a two digit year is entered, Kinnexus reads a Windows
setting to determine the appropriate year.  The default setting assigns the two digits years of 30 and above to the
20th century, and years 29 and below are in the 21st century.  You can view this setting by opening the regional
settings in the Control Panel and clicking on the Date tab. (Windows 98)

What to do

1. From the Home Page, click the Search tab at the left side of the screen.

2. Click the Residential Quick Search icon.  The Search Wizard appears.

3. The Status list box is probably on the first page of the wizard.  (If it is not, continue clicking the Next
button until you see it.)  Click the Active check box.  You will see the text become highlighted.

4. Find the Last Modified field.  You may have to click the Next button to look through subsequent pages
until you find it.  (If the Last Modified field does not appear on the Search Wizard, use another date field,
such as Activation Date or Sold Date.  If no date fields have been included on the wizard, see Search on
Anything, page 44.) Click in the Last Modified field and enter: <Current –1d>.  This criteria finds all the
properties that have been modified in the last day.

5. Run the search by clicking the Go button at the top of the wizard.  You are taken to a list of search results.

6. If you want to modify the search, click on the Edit Criteria button.

Figure 7.41 - The Go button.

Figure 7.39 - The Active check box.

Figure 7.38 - The Residential Quick Search icon.

Figure 7.37 - The Search tab.

Figure 7.40 - The Last Modified field.
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Search for fields not on the Search WIzard
Your Kinnexus system administrator is entirely responsible for the items placed on the Search Wizards. The field
you want to search may or may not be on the wizard.  If a field is not on a wizard, chances are it is on a Search
Criteria Form.  These instructions show you how to search for fields that are not on the Search Wizard using a
Search Criteria Form.

The Search Criteria Form is different from a Search Wizard. It looks like a data entry form or a detailed Search
Result Form.  Search Criteria Forms vary from board to board.  This is a sample portion of what a Search Criteria
Form may look like:

It is easy to compare a Search Criteria Form with a written survey.  There are two parts, questions or sentences
that are written directly on the paper, and blanks where you enter requested information.  Instead of blanks, the
Search Criteria Form has brackets.  You will fill in as many blanks as you want, and then run the search.  You
don’t need to enter all the criteria before running the search.

Most of the criteria is entered in the same way you entered criteria in the Search Wizard.  The one exception is
searching numbers.  In a Search Wizard you entered a range – you entered a minimum and a maximum value.
On a Search Criteria Form, this is how you enter numbers:

Searching on the Criteria Form

To get this Enter This Additional Information

All properties with price
between $120,000 and
$140,000

120000-140000
You don't need to enter the dollar sign and
the commas. Kinnexus adds them
automatically.

All properties less than
$120,000 <120000 This search actually finds all properties less

than or equal to $120000.

All properties greater
than $120,000 >120000

Figure 7.37 - Search Criteria Form.

Figure 7.38 - Entering number ranges in a single box.
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What to do
Here are some instructions for creating a search to find all active properties between $120,000 to $140,000:

1. From the Home Page, click on the Search tab at the left side of the screen.

2. Click the Create Search icon.  The Search Wizard appears.

3. On the left side of the wizard property types are listed.  Click Residential.

4. Make sure that none of the check boxes at the bottom of the wizard have a check mark in them.  If
check marks do appear, click in the check box to make the check mark disappear.

5. Click the Search Criteria Form button. The Search Criteria Form appears.

6. Click in a field.  Your cursor starts blinking in the colored area.

Figure 7.39 - The Search tab.

Figure 7.40 - The Create Search icon.

Figure 7.41 - Using the Create Search icon gives you more options than the Quick Search.

Figure 7.42 - Search Criteria Form.
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7. Press the TAB key on the keyboard 5 times.  Your cursor moves from field to field.  Some times a pop-up
box may appear.  Just press TAB again and the cursor moves to the next field.  TAB takes you forward
through the form.

8. Hold down the SHIFT key while pressing the TAB key.  This is called a SHIFT+TAB.  Pressing
SHIFT+TAB takes you backwards up the form to previous fields.

9. Press the TAB or SHIFT+TAB keys until your cursor is in the Price field.  Type: <150,000-155,000>.

10. Press the TAB or SHIFT+TAB keys until your cursor is in the Status field.  A pop-up list of statuses
appears.  Put a check mark in the Active check box.

11. Run the search by clicking the Go button at the top of the wizard.  You are taken to a list of search results.

12. If you want to modify the search, click the Edit Criteria button.

The Search Criteria Form is a powerful tool because it allows you to search on anything in the database.  In the
Kinnexus for Advanced Users manual you are taught how to create your own search forms.

Test your knowledge
Answer the questions below.  If you need help with one of the answers, refer to one of the previous search
chapters or ask someone.  Be sure to write down any hints you may need next time to help you remember.

1. How many residential listings are active between $140,000 - $150,000?
2. How many active residential listings have a swimming pool?
3. How many residential listings expired last week?
4. How many active listings are on streets that begin with the letters ‘Ch’?
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C H A P T E R

8SAVED SEARCHES
Kinnexus searches are temporary by default. This means that unless you tell Kinnexus to save
a search, each time you run a search the old one is overwritten.  Choosing to create a Saved
Search allows you to come back and look at the results again without having to re-enter the
criteria. This is especially helpful for tracking clients/customers or farming a particular area.
This chapter will show you the basics about saving searches. You will learn how to create a
new Saved Search, how to examine and update a Saved Search, and how to delete a Saved
Search when you are done with it.

Create a Saved Search
A Saved Search can save you a lot of time entering search criteria. You can create as many
Saved Searches as you desire. You must designate a search as a Saved Search at the time you
create the search. You cannot create a temporary search and change it to be a Saved Search in
the future.  These instructions will show you how to create a new Saved Search:

What to do?
1. From the Home Page, click the Search tab.

2. Click the Create Search icon.  The Search Wizard appears.

3. Property types are listed in the Type field.  Click Residential.

Figure 8.1- The Search tab.

Figure 8.2 - The Create Search icon.

Figure 8.3 - The Search Wizard.
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4. Select the Save this search for auto prospecting checkbox at the bottome of the wizard.

5. Click in the Description field at the top of the wizard.  Press the DELETE or BACKSPACE key until
the box is empty

6. Type in a name for the search.

7. The entire dialog box should now look like this:

8. Click the Next arrow button at the top of the wizard.  This will take you into the residential Search
Wizard, or the property type you selected.

9. Enter whatever search criteria on the Search Wizard pages you desire. Click the Go button at the top of the
wizard to run a search, and use the arrows to move to the next and previous wizard pages.

10. Once you have successfully run the search, your search is saved.

Returning to a Saved Search
Once a search has been saved, you can return to it at any time and modify the criteria or review the results.

Beforehand
These instructions assume you have already created a Saved Search. If you haven’t created a Saved Search, see
Create a Saved Search on page 47.

Figure 8.4 - This check mark designates a Saved Search.

Figure 8.5 - Call a search anything you want.

Figure 8.6 - The
Search Wizard.
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What to do
1. From the Home Page, click  the Search tab at the left side of the screen.

2. Click the Search Portfolio icon.  A list of Saved Searches appears

3. Double click the name of the Saved Search you want to view.  You are taken to an updated list of
search results.

How do I know which results are new?
Each time you go to a Saved Search, Kinnexus marks which search results are new since the last time you
looked at the list. The text by default is black.  Kinnexus changes the text color of all new search results.
The color changes as soon as you double click the listing.  They will remain a different color until you
double click them.

Kinnexus reports on the To Do List when a saved search has new results.  You can click the name of the
search in the To Do List to jump directly to the search results.

Deleting a search
As a general rule, you can delete any of the searches in your Listing Portfolio except those that were created
by your office or system administrator. These instructions will show you how to remove a search from your
Search Portfolio:

Beforehand
• These instructions assume that you are looking at the Home Page.  If you are not currently at the

Home Page, click the Home button at the top right of the page.

What to do
1. Click the Search tab at the left of the screen.
2. Click the Search Portfolio icon.  A list of your searches appears.
3. Click the search you would like to delete.  The line becomes highlighted
4. Click the Delete button on the left side of the Next Step Bar.  The search is removed from the list.

Figure 8.7 - The Search tab.

Figure 8.8 - The Search Portfolio icon.

Figure 8.9 - The Home button.

Figure 8.10 - The Delete button.
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Tip
If you have more than one search to delete, you can hold down the CTRL (Control) key on the keyboard and click
all the searches you want to delete, and then click the Delete button.
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SEARCH RESULTS

The previous chapters have taught you how to search the database.  This chapter will cover
how to view search results.  Because of the many possibilities of a Search Result List, this
chapter will refer you to many other places in the manual.  This chapter covers how to move
between Listviews and detailed forms of the search results.  Information about customizing
the Listviews and printing can be found in later chapters.

There are three ways to examine search results: a Listview, a Search Result Form, and a list
of forms.  Each has its advantages.

Listviews
After running a search you are shown a Listview of search results.  A Listview shows one
line for each search result.  This is what a Listview looks like.

Listviews are nice because you can see information about many different properties at once.
Descriptions for customizing Listviews are in Chapter 13.

Printing a listview
Printing a Listview is very easy.  There are two convenient methods you can use.  One
method is to choose File<Print.

C H A P T E R

9

Figure 9.2 - You can print results using the File
menu.

Figure 9.1 - Search Result
Listview.
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Another way to print the Search Result Listview is to use the Print button in the toolbar at the top of the page.

After starting the print process using either of the two methods described above, the Print dialog box appears.
Just click the OK button at the bottom to start printing.

Modify the search
Sometimes you receive too many search results and want to narrow the search so you can obtain fewer results.
There are two buttons on the Next Step Bar that allow you to modify a search: Criteria Wizard and Criteria
Form.

The quickest way to modify a search is to click the Criteria Wizard button. It takes you back inside the Search
Wizard and allows you to modify any of your search criteria. The Criteria Form button lets takes you to the
Search Criteria Form and lets you search for fields that are not on the Search Wizard.

Search Result Forms
The Search Result Listview only shows you one property per line. Although it is true that you can customize the
columns to your liking, you will never see more than one property per line. The Search Result Forms allow you
to see more detailed information about a property.

To see a form of one of your search results, double click the listing in the Search Result Listview.

Figure 9.5 - Two ways to modify a search.

Figure 9.4 - The Print dialog box.

Figure 9.3 - You can also use the Print button in the action toolbar.
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Different forms
The system administrator designates the default form that you will see when you double click on a search result,
but there are many other forms that you can use. The Current Form Indicator in the toolbar shows the name of the
form currently being used. To change the current form, click on the Current Form Indicator, and select a new
form from the list.

Figure 9.7 - A Search Result Form.

Figure 9.8 - The Current Form Indicator shows Residential Search.

Figure 9.6 - A Listview of search results.
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Some of the forms are designed to look like flyers or handbills. Others are small and show only a photo and
summary information about the property. The Kinnexus for Advanced Users manual explains how you can
customize and create your own flyers.

Figure 9.10 - This is the same search
result but it’s displayed using a
different form.

Figure 9.9 - The list shows all available forms.
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Extra photos
Although it is possible to have more than one photo on a form, most forms show only one photo. If you want to
see all of the photos entered for a property, click the Photos button on the Next Step Bar.  The button only shows
up when you are looking at a Search Result Form.

Below is the Picture Information window. It shows all photos available for a property.  A scroll bar appears at
the bottom of the window that allows you to see all of the photos, if all of the photos do not fit in the window.

Close the Picture Information window by clicking the small ‘x’ button in the top right corner of the dialog box.

Back to the Search Result Listview
From the Search Result Forms you can return to the Listview of results by clicking the Back button at the top of
the screen.

Select from a list of photos
Kinnexus Listviews are very powerful.  In normal mode, the Listviews show only one line per property.  How-
ever, you can also make the Listview display photos. This is how you make Kinnexus show a screen full of
photos:

Assuming you are looking at a Listview of search results, click the Current Form Indicator above the Zoom
indicator.  A list of possible forms appears.  You can select any report in the list, but find one that looks some-
thing like ‘Photo 3x3,’ ‘Photo Report,” or even “Res Photo.” Something in the name should give away that its
primary function is to show photos.

Figure 9.13 - The Back button.

Figure 9.12 - This window shows you all of photos that
have been entered for a property.

Figure 9.11 - This button displays the Picture Information window.
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Figure 9.15 - Viewing search results as a
list of photos.

Figure 5.16 - Lower the zoom.

Figure 9.14 - Changing the Listview to a list of photos.
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Change the photo page zoom
You can fit more photos on the screen if you lower the zoom factor.  This is like moving a paper farther away
from you. Click the Zoom “–” button on the toolbar.

If you want to make the photos larger you can raise the zoom factor. This is like moving a paper closer to you.
Click the Zoom “+” button on the toolbar.

Select a photo
You can select a listing from the photo view the same as you can from the Listview.  Simply double click one of
the photos and you are taken to the property form of the result you selected.

More information
There are many more features that can be used with search results. Entire sections and chapters have been devoted
to Listviews and printing. More information is also available in the Kinnexus for Advanced Users manual.

Figure 9.17 - With a lower zoom more
photos fit on the screen.
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SEARCH TUTORIAL
Now that you have all of the pieces, here is a tutorial that can help you put them together.
This chapter demonstrates many of the principles taught in this section and guide you step
by step through the following processes:

• Creating a quick search
• Searching using numbers
• Revising a search
• Printing a list of search results
• Viewing detailed listing information
• Printing a detailed form
• Viewing photos of all the search results.

This guide is meant to take all of the mystery out of searching and search results.  There are
a lot of graphics to help you along.

Searching
1. Start this tutorial from the Home Page. If you are not at the Home Page, click the

Home button in the top-right corner of the screen.

2. Click the Favorites tab.

3. Click the Residential Quick Search icon.  The Search Wizard appears.  This is the
quickest way to start a temporary, residential search.

4. Click in the Price field on the first page of the Search Wizard.  Notice that a
blinking line is now in the box.

Note:
The following instructions and graphics assume that you have only one field next to
search items dealing with ranges.  It is possible that your system administrator has
chosen to display fields dealing with ranges, such as Price and Bedrooms, as two
fields side-by-side. If you come across a search item dealing with ranges that has
two fields side-by-side, enter the minimum value in the left field, and the maximum
value in the right field.

C H A P T E R

Figure 10.2 - The Favorites tray.

Figure 10.3 - The Residential Quick Search icon.

Figure 10.1 - Home button.
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5. In the Price field, type: <250,000-250000>.  This is the price range for the search. Again, you don’t have
to type the comma.

6. Find the Status list box.  Click in the Active check box. A check mark appears in the box.

7. Click the Go button at the top of the wizard.  This starts the search. You are taken to a list of search
results.

8. How many search results are there? ________________________

Revise the search
9. Suppose the number of results you received is too many, and you want to revise the search to retrieve

fewer results.  Click the Criteria Wizard button on the Next Step Bar at the bottom of the screen.  The
Search Wizard reappears.

10. Notice that the criteria you entered before is still entered in the wizard.  Click in the Price field.  After you
click in the box, a vertical line will start blinking in the box.

11. Use the BACKSPACE and DEL keys on the keyboard to erase the number(s) in the Price field.

Figure 10.4 - Quick
Search Wizard. Your
wizard should look
similar.

Figure 10.5 - The Price field

Figure 10.6 - The Active check box in the Status list box.

Figure 10.7 - The Go button.

Figure 10.8 - The Criteria Wizard Button.

Figure 10.9 - Previous criteria in the Price field.

Figure 10.10 - Modified criteria in the Price field..
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12. Type in a new maximum range of: <225,000>.

13. Click the Go button again.

How many results did you receive this time? _________

Sorting a column
14. Locate the Price column in the search result Listview. Click the Price column header.  This sorts

the list based on the price.  Notice that a little arrow appears next to price. The direction of the
arrows informs you if the list is sorted up or down.

15. Click the Price column header again. This flips the arrow, and changes the sort.

Print the list of search results
16. It is very easy to print this list. Choose File>Print. A Print dialog box appears.

Figure 10.12 - The Go button.

Figure 10.13 - Descending column sort.

Figure 10.14 - Ascending column sort.

Figure 10.15 - The Print option on the File menu.

Figure 10.11 - Modified criteria in the Price field.
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17. Click the Print button on the Print dialog box to send the list to the printer.

Examine a search result
18. Double click a search result in the list. The view changes to show you a form of the search result.

View different forms
19. There are several ways Kinnexus can show the listing on the screen.  Click the Current Form Indicator

to see the list of available forms.

20. Click one of the forms.  See how the screen changes to show the new form.  Take the time to go through
each of the forms, each time clicking the Current Form Indicator and selecting a different form.

21. One of the forms will have a photo and just a little bit of information under the photo.  Write the name of
that report here: _________________________  It will look something like this:

Return to the search result list
22. Click the Back arrow at the top of the screen to go back to the Search Result Listview.

Figure 10.16 - The Print dialog box.

Figure 10.17 - A Search Result Form.

Figure 10.18 - The Current Form Indicator.

Figure 10.19 - Name the report.

Figure 10.20 - The Back
button.
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View a list of photos
23. You should now be looking at the list of search results. Click the Current Form Indicator and select the

form you wrote in on step 21.  Several small photos should show up on the screen.

24. Click the Zoom “–” button. Now you can see more photos on the screen.

25. Click the Zoom “+” button. The zoom is returned to normal.

Figure 10.21 - Photo
view at 100% zoom

Figure 10.22 - Photo
view at 80% zoom
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26. Click the Zoom “+” button again. The photos are made larger, but not as many fit on the screen.

27. Click the Zoom “-” button to return the zoom to normal (100%).
28. Double click one of the photos.  You are taken to the Search Result Form of the property you selected.
29. Click the Home button to return to the Home Page.

Figure 10.23 - Photo
view at 120% zoom

Figure 10.24 - The Home button.
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SECTION 4

MANIPULATING COLUMNS

There are many places in Kinnexus where data is presented in a column.  The official
term for the column page is “Listview.” Listviews are lists of items – a list of search
results, a list of your inventory, a list of Realtors, or a list of forms.  The following
chapters will help you learn how to use Listviews. You will learn how to sort columns,
add and remove columns, reorder columns, and how to highlight and print columns.

Listviews in Kinnexus are extremely powerful. You can use them to create statistical
reports or simple books of listings. This manual covers the basic points of creating
listviews. More information regarding Listviews is found in the Kinnexus for Advanced
Users manual.

This section is divided into the following chapters:

Chapter 11: Column Basics
Chapter 12: Highlighters
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COLUMN BASICS
This chapter demonstrates the basic skills needed to use columns in Kinnexus.
You will learn how to sort, add, remove, re-size, and reorder columns. These
skills are very basic, and understanding how to perform them will greatly enhance
your ability to harness the power of Kinnexus.

Sort a list of search results
You can sort a Listview by any of its columns by clicking the column header. If
you are not looking at a Listview, run a search on the database as described on
page 36.  Figure 11.1 shows what a Listview looks like.

1. Click the column header you would like to sort. The column is sorted.
Notice that an arrow now appears in the column header.  The arrow
informs you if the list is sorted up (ascending) or down (descending).

2. Click the column header again to reverse the sort order.

What do the arrow colors mean?
The colors designate which column is the primary, secondary, tertiary, and
quaternary sort orders.  Suppose you want to see a list of search results sorted by
city, but within each city you wanted the results sorted by price.  In this case, city
would be the primary sort and price would be the secondary sort.  See the instruc-
tions below to use sort orders.

Sort by multiple columns
1. Make sure that you have City and Price columns in your Listview.  If they

do not appear, use other columns that appear in your search result
Listview.

2. Click the Price column header.  This makes Price the primary sort
column, meaning the entire list is sorted by price.

3. Click the City column header.  This makes City the primary sort column,
and forces Price to be the secondary sort column.  Notice that the entire
list is sorted by city, and within each city the results are ordered by price.

C H A P T E R

Figure 11.1 - A Listview of search results.
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Add a column
The column list in Kinnexus is completely customizable.  This chapter will teach you how to add
columns to a Kinnexus Listview.

Beforehand
• You should make sure you are looking at a Listview. One of the easiest ways to get to a Listview

is to run a search.  If you need help running a search see page 36.
• Click the View menu. Make sure that a check-mark appears next to Layout Tree on the View

menu.  If there isn’t a check mark, click Layout Tree and the window appears.

What to do
1. Position the Listview so you can see where you would like the new column to appear.

2. Click the plus (+) next to Property or one of the other tables in the Layout Tree.  Find a field
that you would like to add.

3. Click the field you want to add and hold down the left mouse button.  While holding down the
left mouse button, move the mouse along the column headers until it points to where you want
the new column to appear.  Your mouse pointer must be in the column headers and a red line
should appear between the two columns when your mouse is in the correct position.  Release the
mouse button when the red line appears where you want the new column to appear.

From Here

To Here

Figure 11.2 - The View menu.

Figure 11.3 - Drag
fields from the
Layout Tree to the
column header.
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Note:
If the red line does not appear, make sure that you are holding down the left mouse button.
Another common problem is that you did not drag the field from the Layout Tree.  Make sure the
mouse is directly over the field before you hold down the mouse button.

If you are dragging correctly, this symbol appears as you begin dragging the field.

The symbol dispalyed below appears when your mouse is at a location where you could add, or
“drop” a new column.

Why are there different tables in the Layout Tree?
Much like a grocery store divides up its products into groups, Kinnexus divides all fields into several
tables to help you find them faster.  Here is a list of the different tables in the Layout tree and the types
of fields you will find in each:

Table Categories

Table Description Sample Fields

Agent
The agent table has all of the fields that describe
the listing agent. Name, phone number

Office
The office table has all of the field that describe
the listing office.

Price, expiration date,
last modified date.

Common
Listing

The Common Listing table has all of the fields
common to all property types. All property types,
for instance, have a price field. Therefore the
price field is in the Common Listing table.

Address, tax numbers,
city, price

Residential
(Property type)

The residential table is included if you are looking
at a residential property.  If you are looking at a
Land listing, a Land table is included.  This table
contains the fields that are specific to a property
type.

Square feet, bedrooms,
bathrooms

Figure 11.6  - Table types

Figure 7.4 - The dragging symbol.

Figure 11.5 - The drop symbol.
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Remove a column
You can remove any Listview column. For this example you need to be looking at a Listview. If you are not
looking at a Listview, run a database search as described on page 36.

1. Place your mouse pointer over the column you would like to remove.  Click and hold down the left
mouse button. Drag the mouse into the Listview.  Release the mouse when you see this symbol:

2. Repeat the process for each column you want to remove.

Re-sizing a column
Any column can be made wider or narrower.  If you are not looking at a Listview, run a database search as
described on page 36.  You may have to use scroll bars at the bottom of the screen to move the Listview until
you can see the column you would like to re-size.

1. Place your mouse pointer in the column header of the column you would like to re-size.
2. Move your mouse to the right until it is directly over the line that separates the column headers.  Notice

that your mouse pointer changes from a single arrow to a double pointed arrow.
3. When you see the double pointed arrow, hold down the left mouse button.
4. While holding down the left mouse button, move the mouse to the right or left.
5. When the column is the desired width, release the mouse button.  The column is re-sized to your

specified width.
6. Repeat the process for each field you want to re-size.

Automatically re-sizing
Kinnexus knows the optimum width of each column.  The optimum width is just wide enough so that the text
of each line is visible.  To have Kinnexus automatically size a column, follow these instructions:

1. Move your mouse over the line separating column headers as described in step 2 above.
2. Instead of holding down the left mouse button, double click it.  The column is auto-sized.

Reordering columns
You can change the order of any column in Kinnexus.  Any column can be in any position. This is helpful
when you are printing lists and want the most important columns to the left.  You may have to use scroll bars
at the bottom of the screen to move the Listview until you can see the column you would like to move.

1. Place your mouse pointer in the middle of the column header of the column you would like to move.
2. Hold down the left mouse button and move your mouse pointer through the column headers until it is

where you would like the column to appear.  Notice that the line separating the column header turns
red as your mouse passes by.

3. Release the mouse button.

Figure 11.7 - The Release symbol.
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C H A P T E R

HIGHLIGHTERS

This chapter will show you how to organize the search results using highlighters and  how to
print the selected listings.

It is quite normal when reading a textbook or looking over lists of data to use a highlighter to
make specific lines stand out.  In much the same way, Kinnexus uses highlighters to organize
items in a Listview and to hide unwanted items.  There are five types of highlighters you can
use: Red, Yellow, Green, Normal (blue) and Strike-out.  There is nothing significant about the
different colors.  You can use them however you choose.  You may designate a particular
color to mean you want to show that particular property to a client/customer.  Perhaps another
color means you have already shown a property, and yet another designates that you are not
interested in the property.

These instructions will help you learn how highlighters work. If you are not looking at a
Listview, you should run a database search as described on page 36.

Highlighting Items
There are two steps to highlighting items.  First, select the items you want to highlight.
Second, paint them a particular color.  These instructions demonstrate several ways to high-
light search results.

1. Select the items you want to highlight. There are three ways to select items in a
Listview.  Each  method has its advantage:

Clicking Methods

Method What to do Advantage

Single click
Use the left mouse button to click
on the line you want

Clicking on a single line removes all
previously selected lines.

CTRL + click
Hold down the CTRL key on the
keyboard then select all the items
you want to select.

As long as you hold the CTRL Key, all
selected items will remain highlighted.

SHIFT + click

Click on the first item you want.
Then hold down the SHIFT Key.
Finally, click on the last item you
want selected.

This method is great for selecting a
large number of search results that are
next to each other.

Double Click Double clicking is not used with highlighters.

Figure 12.1 - Highlighting methods.
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2 Once you have selected the items you want to highlight, click the Select Highlighters button on
the toolbar.  A list of highlighter colors appears.

3. Click the color you desire.  The selected items change to the color you designated.

Unhighlighting items
To unhighlight items, click the Select Highlighters button and choose the black highlighter.  The black
highlighter removes all highlighting.

Printing highlighted colors
Any group of highlighted listings can be printed separate from the whole list. If you have a large list of
search results and only want to print a few, using highlighters is the best method to choose.  Follow
these instructions.

1. Hold down the CTRL key on the keyboard and use the mouse to click the listings you want to
print. The listings become highlighted as you click on them.

2. Click the Select Highlighters button. A list of highlighter colors appears.
3. Click the yellow highlighter. The selected listings in the Listview become highlighted yellow.
4. Choose File>Print from the menu. The Print dialog box appears.
5. At the bottom of the Print dialog, select the Yellow highlighter check-box.  This restricts

printing to the items highlighted yellow.
6. Click the Print button. The yellow items are sent to the printer.

Incidentally, the highlight color is not sent to the printer. Selected items are printed in plain text.

Figure 12.2 - Highlighter options.
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SECTION 5

MANAGING LISTINGS

Kinnexus provides a versatile environment to enter and maintain your listings.  As has been
noted in previous chapters, because of the customizable nature of Kinnexus, it is possible,
even probable, that what you see on the screen will not exactly correspond with the
graphics provided in this manual. The instructions are written in such a way that field order
is not important.

The chapters in this section will show you how to add and maintain your listing inventory.
You will learn how to add multiple photos to your listings, and how to mark a listing as
sold.

Here is a list of the chapters in this section:
Chapter 13: Listings
Chapter 14: Photos
Chapter 15: CMAs
Chapter 16: Listing Scenarios
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LISTING BASICS
This chapter will give you a brief overview of the different parts of Kinnexus that are used to
add and modify listings. Understanding the different parts will make it easier for you to
maintain your listings.

The basic parts involved in adding and maintaining a listing in Kinnexus are:
• Listing Portfolio
• Sold Listing Portfolio
• Lost Listing Portfolio
• CMA Listing Portfolio
• Listing Wizards
• Listing Data Entry Form
• Photos
• Mapping
• Listing System Tray

Listing Portfolio
The Listing Portfolio is a Listview of all of your listings that are either active, on hold,
contingent, pending, or pre-active (you haven’t finished entering them yet).  As with all
Listviews, you can add and remove columns, change column widths, and change the sort
order of the list.  Double clicking on a Listview entry will take you to a data entry form of
that property.  For more information about adding columns or other Listview features, see
the Columns section on page 65.

Sold Listing Portfolio
The Sold Listing Portfolio is the final resting-place for listings listed as sold.  Only your
system administrator can remove items from your Sold Listing Portfolio, but you can hide
the older items you no longer wish to access.  For information regarding hiding columns,
adding columns, or other Listview features, see Columns on page 65.

Lost Listing Portfolio
The Lost Listing Portfolio is for listings you listed that did not sell.  These are withdrawn or
expired listings.  If you accidentally forgot to extend the expiration date on a listing, it is
possible to retrieve it from the Lost Listing Portfolio, and reposition it in your listing
portfolio.

CMA Listing Portfolio
The CMA Listing Portfolio contains temporary listings that have been entered as a Subject
Property for a CMA.  They are not part of your inventory.

C H A P T E R
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Listing Wizard
The Listing Wizard is used to create new listings and steps you through many of the required fields.  It
also allows you to designate the listing agent for a listing, just in case you are adding the listing for
someone else.  Again, this is one of many things that can be customized in Kinnexus.  There are several
features on the wizard.

1. Cancel button – Use the Cancel button any time you want to cancel out of the Listing Wizard.
2. Previous button – The Previous button returns you to the previous wizard page.
3. Next button – The Next button takes you to the next wizard page.  If the arrow does not have color,

you are at the end of the wizard.
4. Form button – When you are at the end of the Listing Wizard, you should click the Form button. The

Form button will take you to the listing input screen. All listing fields are contained on the Listing
Input Form.

5. Fields – Use the TAB key to jump between the different fields.   Your system administrator chooses
which fields appear on the wizard.

Listing Data Entry Form
The Listing Data Entry Form contains all of the listing fields, including those that you filled in on the
Listing Wizard.  If you wish to add a field not on the Listing Wizard, you can find it on the Listing Data
Entry Form. The TAB key will jump you from field to field.  .

Photos
You can add as many photos to a listing as you want.  Your system administrator can monitor the number
of photos that you add to a listing and may choose to set a lower limit than the one contained in Kinnexus
by default.  All that you need to enter or update a listing photo is an electronic copy of the photo, either
from a digital camera or a scanner.  For more information about entering and maintaining listing photos,
refer to Adding a Photo on page 81.

Mapping
Kinnexus has integrated mapping.  After entering the listing address, Kinnexus should be able to deter-
mine on a map where the listing is located.  You can verify the location on a map, and adjust the location
if necessary.  You can zoom in on a map to show all of the street information, or zoom out to show you
where the property is located in relation to the rest of the community.

Listing System Tray
The tabs at the left side of the Home Page contain the major parts of the Kinnexus program.  One of the
tabs is the Listing tab.  The Listing tab contains icons that link to many of the listing parts described
above.
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From any Listview, whether it be the Listing Portfolio, Sold Portfolio, or Lost Listing Portfolio, you can double
click a line to take you to the Listing Form of that particular property.

Adding a listing
Your system administrator can grant you permission to enter your own listings into the database.  This chapter
will show you how to create new listings and fill the listing records with information.

There are two parts to adding a listing. The first part shows you how to enter information into the Listing Wizard.
The Listing Wizard contains a few of the required fields. More than likely, you will not enter all of the fields in
the Listing Wizard. You will need the second part, or the Listing Form, to complete the data entry process.  All of
the listing fields should be present on that form, both required and non-required fields. Entering as much infor-
mation as possible about a listing is advantageous to you as a listing agent. Because of the methods Kinnexus
uses to search the database, your listing is more likely to be a match if you have complete information.

If you are not at the Home Page, click the Home button at the top-right corner of the screen.

Listing System Tray Icons

Icon Name Description

Listing Portfolio Clicking on the Listing Portfolio button takes you to a list of all your
listings that are either active, on hold, contingent, pending, or pre-
active (pre-active listings are ones that you haven't finished entering
yet).

Sold Listing
Portfolio

All the listings you have sold appear in your sold listing portfolio.

Lost Listing
Portfolio

The Lost Listing Portfolio contains all of the listings you had at one
point, but were either withdrawn or expired.

CMA Listing
Portfolio

The CMA Listing Portfolio contains temporary listings that have been
entered as a subject property for a CMA. They are not part of your
inventory.

Create Listing Use this command to begin entering a new listing.

Create CMA Use this command to perform a basic CMA.

Find Listing Find Listing is a utility to help you locate the listings you have
permission to edit.

Figure 13.1 - Listing tab icons.
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Part 1: The Listing Wizard
1. Click the Listing tab at the left of the screen.

2. Click the Create Listing icon.  The Listing Wizard appears.  Your system administrators can customize
the Listing Wizard, so it may look different than the one pictured here.

3. The first page of the Listing Wizard probably asks you to designate a property type and specify the listing
agent. Click on the property type of the listing you are adding.

4. Click your name in the Owner window, or the name of the person for whom you are entering the listing.
If you only have rights to add listings for yourself, only your name should appear in the left window.

5. Click the Next button (the right arrow at the top of the page) to go to the next page of the wizard.

6. The second page of the wizard has field information. Usually the page contains a Listing Price, Expira-
tion Date, and other various fields. Some or all of these fields are required. It is up to your system
administrator to designate whether you can progress through the wizard without entering information in
one of the fields.  Use the TAB key to jump between the fields.

7. What you do next depends on how many pages your system administrator has created in your Listing
Wizard. If the Next button still has color, your system administrator has other wizard pages for you to
enter. Click the Next button and enter the desired and/or required information on each page. When you
come to the end of the wizard, the Next button becomes gray. Click the Go to Form button. Your view
will change to show you a detailed Listing Form.

Figure 13.2 - The Create Listing icon.

Figure 13.3 - The Listing Wizard.

Figure 13.4 - The Next button.

Figure 13.5 - The Listing Wizard field information.

Figure 13.6 - The Go to Form.
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Part 2: The Listing Form
Much like a Search Form, there are two parts to a Listing Form – text labels and fields.  To enter data you
will click in one of the fields with the yellowish background and a cursor will start blinking.  Enter the data
you want, then press TAB to go to the next field.  You can skip to any fields you want by clicking the mouse
in any field in which you want to enter information.

Some fields will have pop-up dialog boxes, depending on the type of field.  Below are examples of some of
the dialog boxes, and how to appropriately answer them:

Boolean Fields
Click in the box to enter a check mark if the listing has that particular field.  A check mark means true,
leaving it blank implies false.

List Box
A list box is a list of options from which you can select only one item.

Feature Box
A Feature Box is a list of options from which you can select all that apply.

Combo Box
A combo box is a list of text options.  You can select an item from a list, or, if the item you want doesn’t
appear in the list, you can type in your own response.

Figure 13.7 - Boolean fields dialog.

Figure 13.8 - The List Box dialog.

Figure 13.9 - The Feature Box dialog.
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What if I don’t have all the information right now?
If you don’t have all the necessary information right now, you can save the listing and come back later
and add the necessary data.  To save the listing, choose File>Save from the menu.  The listing will be
saved as a pre-listed listing, which means it is not actively on the market yet.

To finish a listing that you previously left incomplete, you should:
1. From the Home Page, click the Listing Portfolio icon on the Listing tab.  A Listview of your

listings appears.

2. In the list of properties, double click the pre-active listing you want to finish.  This is also true of
any other listing you wish to edit.  The Listing Information Sheet appears.

3. Click in the field you want to enter.  The cursor starts blinking in that field. Enter the value you
desire.  Continue editing other fields by pressing TAB, or using the mouse to select a different
field.

4. When you are finished editing, choose File>Save from the menu.

How do I make the listing active?
Once you have added all the required fields, Kinnexus will allow you to make the listing active.  Click
the Activate button on the Next Step Bar at the bottom of the screen.

Status Changes
Because each Kinnexus site can modify the original set of statuses, it is impossible to document all
possible status changes. There is a rule that can be followed, however. Status change icons appear on the
Next Step Bar whenever you are looking at one of your listings. Click the appropriate icon to change the
status.

The instructions for bringing up one of your listings are the same as included in the section above. Click
the Listing Portfolio in the Listing tab to bring up your inventory list. Then double click the listing you
want to mark as Sold, Pending, Withdrawn, or whatever other statuses you have. After double clicking
the property, the Property Information Form appears. At the bottom of the screen on the Next Step Bar
there are buttons for changing the status of the listing. Click once on the appropriate icon.

Figure 13.10 - The Listing Portfolio icon.
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Icon Status Description

Pre-Active

A Pre-Active listing is one that you are in the process of adding. If you
choose to save your listing before the listing is activated, it will receive
the status of Pre-Active. Pre-Active listings are not included in
searches.

Active Active listings are on the market. They can be searched by the entire
MLS.

Hold

Hold is a special designation that a listing is temporarily off the
market. If an owner had a death in the family, or some other event
where they didn't want to show the house for a few days, you could
change the status of the house from Active to Hold. Other agents can
still search and find listings that are on Hold, but the Hold Status
informs you that it is temporarily unavailable.

Contingent
Mark a listing Contingent if someone has made an offer on the
property, and you have accepted the offer, but the offer contained
contingencies such as "Depending on the sale of another property."

Pending
Pending sales are similar to contingent sales, except in a pending
sale, the only thing that you are waiting for is the financing. There are
no other encumbrances.

Sold
Once you have closed on a property you should record the sold
information in the database. Use the Sell Listing Wizard to mark a
listing sold.

Expired
When the current date passes the expiration date, your listing is
marked as expired.  The expiration happens automatically. Once a
listing expires, it is moved to your "Lost Listing Portfolio."

Figure 13.11  The original list of statuses. Your administrator may add or remove statuses from
this list.
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PHOTOS

Photos play an important part of your listings.  For many clients, the photo will say much
more than numbers and text.  It is important, therefore, that your photo is a good represen-
tation of the property.  To help you capture the essence of the property, Kinnexus allows
you to add more than one photo per property.   This chapter will show you how to enter a
new photo, how to change a photo, and it will give you some basic tips for day-to-day
MLS use.

Viewing existing photos
Since you can enter more than one photo for a listing, you are not guaranteed to
see all the photos by looking at the listing forms. Here is a method to see all the
photos for one of your listings.

1. Start at the Home Page.
2. Click on the Listing tab in the Task Bar.

3. Click on the Listing Portfolio icon in the Task Bar. You are shown a
Listview of your properties.

4. Double click a listing.
5. Click the Photos button on the Next Step Bar.

6. This is the Picture Information dialog box. This dialog shows all of the photos
entered for this property.  Use the scroll bar or the arrow buttons to view all of the
photos entered for the property.  You can double click on a photo to see the photo
full size.

C H A P T E R
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Figure 14.1 - The Listing tab.

Figure 14.2 - The Listing Portfolio icon.

Figure 14.3 - The Photos button.

Figure 14.4 - The Picture Informa-
tion dialog.
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Adding a photo
The following instructions will show you how to add one or more photos to a listing. In order to add a photo to
Kinnexus, the field must first be stored in a graphic file such as a jpg or bmp, and you must know where the file
is stored on your computer.

1. From the Home Page, click the Listing Portfolio icon on the Listing tab.  A Listview of your listings
appears.

2. Double click the listing to which you want to add a photo.
3. Click on the Photos button on the Next Step Bar.  The Picture Information dialog box appears.

4. Click the Open button.  A File Open dialog box appears.

5. Select your photo file from the floppy disk or your hard drive. Click the Open button.  Your photo is
entered into the Kinnexus database.

6. Your system administrator has designated several types of photos that can be entered into the system.
Click the Photo Title drop-down menu to see the photo types. The main photo, the one you want to
appear in the book, should be designated as the Main photo.  If your photo does not match one of the
preset definitions, there are usually several Other designations you can choose.

What kind of files does Kinnexus take?
Kinnexus can read almost any graphic file format. Here is a list of the most common file types.

• JPG
• GIF
• BMP
• TIFF
• Kodak Photo CD

Figure 14.5 - The Listing Portfolio icon.

Figure 14.6 - The Photos button.

Figure 14.7 - The Open button.

Figure 14.8 - The Photo Title drop-down menu.
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If Kinnexus does not recognize the format of your graphic file you will get an error message. If that happens, try
to have your files converted to one of the above formats. Scanners and digital cameras almost always give you a
choice of file formats.

How many photos can be entered?
You can enter several photos for each listing. Your system administrator can change the maximum number
allowed. If you try to add too many photos to a listing, you will receive a message informing you that the
maximum number has been reached.
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CMAS
Kinnexus includes a simple CMA function in the basic Kinnexus package.  The basic
CMA functions will allow you to enter a Subject Property, search for comparable
properties, and print search results.  A CMA add-on module that has enhanced printing
capabilities is available from Telescan.

Perform a CMA
There are three parts to a Kinnexus CMA:

1. Enter Subject Property
2. Create CMA search
3. Print CMA search results

Step 1 shows you how to enter a Subject Property.  You can enter several Subject
Properties for convenience.  Subject Properties are not searchable, and appear only in
your CMA Portfolio.  In step 2 Kinnexus helps you create a search based on your subject
property.  It is a special relevancy search designed to help find the best matches.
Kinnexus automatically fills in much of the criteria for you.  In the last step, you will
weed through the search results and choose the properties you want to print using either
a standard form, or a custom form you have created.

Step 1: Enter a Subject Property
The first step to run a CMA is to enter a Subject Property.  This Subject Property will be
a basis for entering search criteria in step 2.  Each CMA search must have a Subject
Property.  Because of this fact, you may want to keep a blank CMA Subject Property
around for running a CMA without a Subject Property.

Here are the steps to create a CMA Subject Property:

1. Return to the Home Page by clicking the Home button.

2. Click the Listing tab at the left of the screen.

3. Click the Create CMA icon. The CMA Listing Wizard appears.

C H A P T E R
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Figure 15.1 - The Home button.

Figure 15.2 - The Listing tab.

Figure 15.3 - The Create CMA icon.
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4. Enter the desired information in the wizard.  You can skip any information you think is irrelevant. Click
the Next button to move to the next page of the wizard.

5. When you have entered as much information in the wizard as possible, click the Go to Form button.  The
Listing Data Entry Form appears.

6. This is similar to adding a listing.  Enter as much information as you can about the property.  You can
skip any information you think is irrelevant or unimportant, but you will get more accurate results if you
enter as much information as possible.

7. Save the subject property by choosing File>Save from the menu.

Step 2: Create the CMA Search
Once you have created a CMA Subject Property you can create a CMA search.  Kinnexus will use the informa-
tion you entered for the Subject Property to create default search criteria.

CMA searches use a more powerful way to search called Relevancy Searching.  In a Relevancy Search, you
assign how important each search item is to the overall search.  The price of a listing, for instance, might be more
important than if the yard is fenced.  The importance levels are low, medium, high, very high, and required.  Each
importance level has an associated point value. When searching, Kinnexus compares each listing with the search
criteria, and adds up the point values for all the matching criteria.  The listings with the highest point totals are
considered the best matches.

Here are the steps to create a CMA search:

1. You should be looking at a CMA Subject Property.  If you are not, follow the steps outlined in Enter a
Subject Property on page 83-4.

2. Click the CMA Search Wizard button on the Next Step Bar.  A CMA Search Wizard appears.  You may
notice that this wizard is a bit different because some of the search values have already been entered.
These values are based on your Subject Property and can be edited at will.

3. Enter or edit any extra criteria you desire to retrieve more accurate results.
4. Set the importance of the criteria items.  Remember that the more important a criteria item is, the more

weight it will carry during the search process.  Click the relevancy number to rotate through the relevancy
values.

Figure 15.4 - The CMA Listing Wizard.

Figure 15.5 - The Go to Form button.

Figure 15.6  - The CMA Search Wizard button.
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L – Low
M – Medium
H – High
V – Very High
R – Required:  A listing will not match unless it matches this search criteria

5. Click the Go button at the top of the wizard.  You are taken to a list of search results.

How do I get back to the CMA search criteria?
After running a CMA search you may find that you have too many search results to work with, or maybe you
have none.  It is possible to get back to the CMA Search Wizard to edit your search.  Click the Criteria Wizard
button to edit a search, then follow the previous steps to edit the search.

Step 3 – Print comparable properties
After running a search you are able to look through the search results and hand select the properties that you want
to print as part of your CMA.  After selecting the items you want, you can print them using a standard system
form, or use one of your own custom forms.  If you don’t like the selection of reports available you can learn how
to create your own reports in the Kinnexus for Advanced Users manual.

Designate Comparables
1. Click a listing that you would like to use as a comparable property.
2. Click the Highlighter Selection button on the toolbar.  Select the yellow highlighter from the list.  The

selected listing turns yellow.
3. Repeat this process to highlight all comparable properties.

Figure 15.7 - The Criteria Wizard button.



86 Section 4 - Listings

Print Comparables
1. Click the Print button on the toolbar or select File>Print from the menu.  The Print dialog appears.

2. Click in the circle next to Include selected rows. A dot should appear next to it.
3. Put a check mark next to Yellow highlight.  Remove all other checks in the section.
4. From the Resource field, select an appropriate report for printing CMAs.  Most boards have created a

CMA 3 Up report, which prints three properties on a page.
5. Click the OK button.  All search results you highlighted yellow will be printed using the designated

form.

Kinnexus Add-On CMA
The basic Kinnexus CMA helps you find comparable properties based on a subject property and allows you to
print them using a standard or custom form. Added functionality, such as adding charts and graphs, are included
in the CMA add-on module.  Contact your MLS office for more information regarding the add-on CMA
module.

Reprinting a CMA
CMA searches are saved with the CMA subject property.  Until you delete a subject property you can print the
CMA you created for the subject property.  These instructions will help you return to a CMA that you have
already created to print another copy of the CMA. These instructions assume that you have already created a
CMA.

1. Click the Listing tab at the left of the screen.
2. Click CMA Listing Portfolio icon on the Listing tray.  A list of previously created CMAs appear.

Figure 15.8 - The Print dialog.

Figure 15.9 - The CMA Listing Portfolio icon.
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3. Double click the name of the CMA you would like to reprint.  You are taken to a listing detail form.
4. Click the CMA Search button on the Next Step Bar.  You are taken to a list of search results.
5. The items that you originally highlighted should still be highlighted.  If not, you will need to select the

comparable properties to print.
6. To print the CMA, click the Print button on the toolbar, or choose File>Print from the menu.

Deleting a subject property
After you are done with a Subject Property you can delete it at any time.  It is suggested that you delete all
Subject Properties that you are not using so that you don’t clutter your CMA portfolio and increase clutter on the
server.  Below are instructions for removing a Subject Property. These instructions assume that you have a
Subject Property that you want to delete.

1. Click the Listing tab at the left of the screen.
2. Click the CMA Listing Portfolio icon on the Listing tab.  A list of previously created CMAs appear.
3. Click the name of the CMA you would like to delete. Only click once on the line.  The entire line should

become selected.
4. Click the Delete button on the Next Step Bar.  The selected item is deleted from the list.

Figure 15.10 - The Delete button.
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C H A P T E R

16LISTING SCENARIOS
Here are some common scenarios that you might encounter.  Although there are instruc-
tions elsewhere in the chapter that would show you how to solve these problems, these
scenarios may be more helpful because they present real world problems.

Scenario 1: Updating a price
Suppose the owner of the listing MLS# 123456 has decided to lower the asking price from
$150,000 to $145,000.  These instructions will walk you through the necessary steps to
record the price change in the MLS.

1. Start at the Home Page.  If you are not there already, click the Home button at the
top-right of the page.

2. Click the Listing tab.

3. Click the Listing Protfolio icon.  A listview of all your listings is exposed.
4. Look for MLS #123456 among your listings.  Double click it.  The Listing Form

appears.  (If you don’t have a column for MLS#, see page 58 for information on
adding columns.)

5. Locate the Price field on the Listing Form.  Click the mouse while pointing
directly the figure in the Price field.  Your cursor should start blinking in the Price
field.

6. Erase all of the numbers in the Price field using the BACKSPACE and DELETE
keys.

7. Type: <145000> in the Price field.  You don’t need to type in the dollar sign or the
comma.  Kinnexus will automatically insert those symbols.

8. Select File>Save from the menu.  This saves the change to the Kinnexus database.

Figure 16.1 - The Home button.

Figure 16.2 - The Listing tab.

Figure 16.3 - The Price field.

Figure 16.4 - The Price field.
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Scenario 2: Update a photo
It is now spring and you want to update the photo of MLS listing #123456 from a winter photo to a recent spring
photo.  These are the steps you would follow to add a new photo, and designate it as the summary photo.

1. Start at the Home Page.  If you are not there already, click the Home button at the top-right corner of the
screen.

2. Click the Listing tab at the left of the screen.
3. Click the Listing Portfolio icon.  A Listview of all your listings is exposed.
4. Look for MLS #123456 among your listings.  Double click it.  The Listing Form appears.  (If you don’t

have a column for MLS#, see page 66 for information on adding columns.)
5. Click on the Property Photobook icon on the Next Step Bar.  The Picture Information box appears.
6. Click on the Open button.  It looks like an open file folder.  A File Open dialog box appears.
7. Select the New Photo file.  If it is on the floppy disk, you may have to type:  <A:\>  in the filename box,

so you can see the various files that are on the floppy disk.  Once you have highlighted the proper file,
click the Open button.  The file is read into the database.  The photo is entered into the database with the
caption, Unassigned.

8. Only one photo can have the designation Main Photo.  If another photo is currently designated as the
Main Photo, double click the photo.  You have to change it to another designation before the new photo
can be designated as the Main Photo. Once the photo appears, click the Photo Title drop-down arrow.
Click Unassigned from the drop-down menu. Press the ENTER key on the keyboard.

8. Double click the new photo you just entered into Kinnexus. The photo appears full size. Click the Photo
Title drop-down arrow. A list of possible titles appears. Select Main Photo from the list. Press the
ENTER key on the keyboard.

9. To close the Photo Information dialog box, click the small ‘x’ button in the top right corner of the Photo
Information dialog box.

Figure 16.5 - The Photo Title drop-down menu.
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It is extremely easy for Kinnexus to share information with different applications. This
is helpful for Realtors wanting to take advantage of Internet browsers and email, as
well as other real estate applications. This section of the manual will demonstrate
several ways to get information from Kinnexus to other programs. Specifically, you
will learn how to export a listing or group of listings to Top Producer or a text file.
You will also learn how to send and receive Internet Email and access Internet web
pages from within Kinnexus.

SECTION 6

INFORMATION EXCHANGE

This section is organized in the following way:

Chapter 17: Exporting
Chapter 18: Web Browser
Chapter 19: Basic Email
Chapter 20: Download Data
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EXPORTING
It is extremely easy to get your data out of Kinnexus and into another program such as
Microsoft Excel or Top Producer. This section will not go through every aspect of exporting
data, but will outline the most common exporting features. Power users will find added
exporting information in the Kinnexus for Advanced Users manual.

Exporting to Top Producer
Kinnexus is compatible with Top Producer. You can move your listings and search results
from Kinnexus into your Top Producer program. This is helpful if you are particularly apt
with Top Producer.

Some legacy systems allow Top Producer to dial directly into their servers. This is not an
option with Kinnexus at the present time. Instead, Kinnexus users download a file that Top
Producer can read. This process is called “exporting.”

There are two basic steps in exporting listings. First, you have to tell Kinnexus which listings
you would like to export. This is most commonly done with a search. The second step is to
designate the format in which to save the listings.

For this example you need to be looking at a list of search results. If you are not familiar with
how to run a search, see page 36.

What to do
Listings can be selected from any portfolio -- the Listing Portfolio, Lost Listing Portfolio, or
the Sold Listing Portfolio. You can also export listings from lists of search results. This
example demonstrates how to export listings from a list of search results. Although it is
possible to export only a portion of the list, this example will export the entire list of search
results.

1. Assuming you are looking at a list of search results, choose File>Export from the
menu. The Export Format Dialog appears.

2. Click Top Producer tag format.
3. Click the Export button. A Save As dialog box appears.
4. Use the Save in: drop-down menu to designate where you want the file saved. If you

are unfamiliar with how to designate a different directory, simply click the Save
button and the new Top Producer file will be saved in the Kinnexus Directory.

In order to use the Top Producer file created by Kinnexus, you will need the Kinnexus
version of Top Connector, which can be purchased from Top Producer, Inc. The instructions
included with Top Connector explain how to read the file Kinnexus created.

Exporting to other formats is just as easy. Simply repeat steps 1-4 above, choosing a different
format on step 2.

C H A P T E R
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THE WEB BROWSER
Kinnexus has a built-in Internet browser that allows you to view and search web pages inside
the Kinnexus program. The web browser functionality only works if your MLS is connected
to the Internet. Most MLS boards are -- but if you are not sure, check with your board.

In this section you will learn to:
• Check preexisting links to web pages using the To Do List.
• Browse the www.kinnexus.com web page

Your system administrator has control over the pages that you are able to view inside
Kinnexus. They may give you free range on the Internet, or they may limit access to only a
few pages. Not all of the web functionality is discussed in this book. The Kinnexus for
Advanced Users manual has a more complete list of tools and suggestions for using the web
tools in Kinnexus.

Check web links
Web links are items in the To Do List. Clicking a Web Link loads a designated web page.
The system administrator can designate Web Links for the entire board. The Kinnexus for
Advanced Users manual explains how to create your own custom links. These instructions
will teach you how to use a link that has already been created. These instructions assume that
you are at the Home Page. If you are not at the Home Page, click the Home button at the top
right of the screen.

1. Locate the Web Links in the To Do List. All web links start with the word “View.”
2. Click one of the Web Links. You are taken to the specified web page.

After using a To Do Web Link, a check mark appears next to the link indicating that you
have performed that feature. The check mark disappears the next time you log in.

Go to a specific web page
Depending on the browsing restrictions set up by your MLS, you can use Kinnexus to
browse any page on the Internet, including those not associated with one of your links. This
chapter explains the basics of the Internet browser and describes how to visit the Kinnexus
Home Page.

These instructions assume that you are looking at the Home Page. If you are not looking at
the Home Page, click the Home button on the toolbar.

1. Click the Internet tab at the left of the screen.
2. Click the Home Page icon. The main view changes to show you your Internet home

page.

C H A P T E R
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Parts of the browser
The Kinnexus web browser works like any other web browser. Here are the different parts of the Kinnexus web
browser:

1. Previous page button
2. Next page button
3. Stop
4. Refresh
5. Internet Home Page
6. Create Kinnexus Internet Link
7. Current Web Page (URL)

Go to another web page
If you want to go to a particular page all you need to do is enter the URL.

1. Click in the URL field. This field is found at the top of the screen to the right of the Delete button.
2. Erase the URL that is there by pressing the DELETE or BACKSPACE keys. Erase everything on the

line.
3. Type <www.kinnexus.com>.
4. Press the ENTER key. You are taken to the Kinnexus web site.

Important note
Your system administrator has control over how much of the Internet you have access to. Some boards may
restrict Internet access to just a few sites. If there is a site that you would like to access, but are unable to, talk
with your system administrator.

Figure 18.1 - Kinnexus web browser buttons.
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BASIC EMAIL
Email has fast become an integral part of many Realtors’ daily routines. Email is a fast,
convenient, and environmentally friendly way to stay in touch with co-workers and
clients. Since Kinnexus uses Internet email (Pop 3 compliant), you can use it to send
email to people anywhere around the world.

Here are a few of the ways you can use Kinnexus email:
1. Read your Internet email.
2. Send email to people/clients around the world.
3. Send email to other agents. Every agent has his or her own Kinnexus email

address.
4. Easily attach listings, lists, or files to your email messages.
5. Post and read messages to Kinnexus News Groups.

Read new email
This chapter will show you some basics of using email. Such skills include how to
determine if you have received new mail, and how to send messages.

How do I know I have new mail?
When you have new email, you will see an entry in the To Do List on the Home Page
informing you the number of new messages. If  you have two new messages, the To Do
List will contain an entry that says: 2 new email messages.

Follow these instructions to read your email:
1. If you are not at the Home Page, click the Home button at the top-right of the

screen.
2. Click the To Do item that informs you of the number of new mail messages. Click

it even if it says zero. You are taken to your email Inbox.
3. New email messages appear in a color other than black.
4. Double click the message you would like to read. The message text appears. If the

text is longer than can fit in the window, a scroll bar appears on the right edge of
the screen that can be used to read the rest of the message text.

At this point there are several things that you can do with the email message. Notice there
are several buttons at the top of the email message. These represent the different methods
you can use to respond or print the message. These options will be familiar to those who
have used an Internet mail program previously.

C H A P T E R
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Send email
To send an email message, follow these instructions:

1. Clik the Create Message icon on the Mail tab. A blank email message appears.

2.  Click in the To: field.  Type the email address of the person you want to receive the message.
(You can also click the word To: to bring up your address book.)

3. Press the TAB key on the keyboard to go to the Subject field.  Enter a brief subject about the
email message.

4. After entering the subject, press TAB and type your email message.  When you are finished with
the message, click the Send button at the top of the email window.

Read newsgroups
Newsgroups are special email messages that are used to communicate with a large group. Posting to a
newsgroup is like putting a notice on a bulletin board. There can be several different groups where you
can post a message. The idea is to keep a common theme to the messages in each newsgroup. There
could be, for instance, a newsgroup for any new tips or tricks people have discovered that helps them
use Kinnexus. If you discovered a new trick you would post a message to the group. You could also
peruse the messages in that newsgroup every once in a while to see what you can learn. Another
newsgroup could be for open house announcements, or for any general announcements you want to
make to the membership.

What newsgroups are available?
Your local board has created the set of newsgroups that are available. Every board will have different
newsgroups depending on the needs of their members. You can only join the newsgroups for which you
have sufficient access. The MLS administrator is ultimately responsible for assigning access. To see
which newsgroups you can access, follow these instructions.

1. These instructions assume that you are at the Home Page.
2. Click the Mail tab at the left of the screen.
3. Newsgroups are represented on the Mail tab as icons resembling newspapers. Click one of the

newsgroups icons.
4. You are now looking at a list of all the messages that have been posted to this newsgroup. If the

list is empty, it is because there haven’t been any messages posted to this newsgroup yet, or it
could be that you don’t have any columns selected.

5. When someone replies to a message, Kinnexus indents the reply in an outline fashion. Clicking
on a plus (+) expands the outline so you can see the replies to a message. Clicking on a minus
sign (-) collapses the tree.

6. Double click one of the messages to read its contents.
7. Standard email functions such as Reply, Reply all, Forward, and Print are available.
8. To close a newsgroup message, click the small ‘x’ at the top right of the message window.

Figure 19.1 - The Create Message icon.

Figure 19.2 - The Price field containing a maximum value.
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Can I read Internet newsgroups?
Although they function much the same way, Kinnexus newsgroups are not connected to Internet newsgroups.
Likewise, you cannot use an Internet news reader to browse Kinnexus news.  Information posted to Kinnexus
newsgroups is available only to other Kinnexus users in your MLS.

Post a newsgroup message
So far you have learned a little about newsgroups and how to read them. The following instructions show you
how to post your own message to an existing newsgroup:

1. This example starts from the Home Page. If you are not at the Home Page, click the Home button at the
top-right corner of the screen.

2. Click the Mail tab at the left of the screen.
3. Double click the newsgroup to which you want to post a message.
4. Click the New Message button on the Next Step Bar. A new mail message is created and pre-addressed to

the name of the current newsgroup.
5. Click in the Subject field and type a subject for your new message.
6. Press the TAB key to move from the Subject field to the text body.
7. Type your desired message. There are formatting tools on the toolbar in case you want to change the font

characteristics.
8. When you are finished typing your message, click the Send button. Your message is placed in the

Mailbox. The mail message closes automatically for you, and you are returned to the list of posted
messages. You should be able to find your message in the list.
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DOWNLOAD THE DATA
One of the many excellent features of Kinnexus is the ability to download part or all of the
database to your own computer. This allows you to take the database with you wherever you
go. With a downloaded database you can access the information on your computer without a
phone connection to the Kinnexus server.

Another bonus of Kinnexus is that you can make changes to listings either online or offline.
After making changes to one, the other database is updated automatically the next time the
databases are connected. Kinnexus is one of the few systems that allow you to change the
local or server database. Because Kinnexus not only copies data from the server, but also
updates the server with changes made offline, we like to use the term “Data Replication”
rather than “Downloading.” Downloading is just a one-way copy. Kinnexus copies informa-
tion two ways.

How do I replicate data?
The process of replicating data has been greatly simplified for your convenience. This
chapter explains the concept of a “Replication Profile,” and shows you how to join a profile.

Your access level controls your ability to replicate data. You will not be able to download
data unless your administrator has given you permission.

What is a Replication Profile?
You tell Kinnexus that you want to download data by joining a Replication Profile. A
Replication Profile is a preset definition or groups or areas of listings. Kinnexus keeps the
properties defined in the profile up to date on your computer.  A profile might look some-
thing like this:

1. Download all residential properties in areas 10-30. Download photos for each of the
listings.

2. Download areas 31-36, but without photos.
3. Download my own inventory.

Each time you connect to the server computer, Kinnexus checks your computer to see if it is
up-to-date, and it is updated with the most current information.

You can only join one Replication Profile. Advanced users who have been granted proper
permission can create their own Replication Profiles if they desire. The process of creating
your own Replication Profile is outlined in the Kinnexus for Advanced Users manual.

How do I change Replication Profiles?
You initially joined a Replication Profile the first time you logged on to Kinnexus. You can
change Replication Profiles at any time. Here are instructions to help you:

1. Choose Tools>Replication Files from the menu. A list of profiles appears.
2. Click the Replication Profile you desire.

C H A P T E R
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3. Click the OK button. After selecting a new Replication Profile, Kinnexus will download the initial set of
information to your computer. This process is called a “cold start.” This process could take just a few
minutes or a couple hours, depending on the amount of information you choose to download.

A day-to-day replication example
You can update your local database as often as you want -- once a week or several times a day. It is important to
keep your replication up to date. Connecting to the server frequently means there is less to download, and
therefore the download takes place more quickly. Also, frequent updates keep your database accurate.

Manual Update
During an update, any information you have changed offline is copied to the server. To update the server at any
time, simply select File>Update Server from the menu.
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SECTION 7

APPENDICES

This section is organized in the following way:

Appendix A: Installation
Appendix B: Configuration
Appendix C: Logon
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Although only the standard Kiinexus installation option is covered in Chapter 1, there are
four installation options available from the Kinnexus Setup screen. This appendix describes
all four installation options, tells you when and how to install them, and identifies
customizable features within each installation option.

Setup Screen
When you begin  installing Kinnexus, you will come across the Setup screen containing
four installation options:

Kinnexus
Local Database Client
Local Database Server
Internet Explorer 5.0

Kinnexus Installation
Click the Kinnexus installation option to install the Kinnexus database and software on
your computer. This option will  install only the necessary files for Kinnexus to be used on
a server. If you wish to replicate data with Kinnexus you will need to install the Local
Database Client or Local Database Server software after the installation of Kinnexus.

During Kinnexus installation there are two places where you can customize Kinnexus
options and features. Below are instructions on how to customize these options and fea-
tures. See Chapter 1 for information about where these processes fall in the installation
processes.

Directory
During the installation process you will come to the Directory screen. You can choose to
install to the default directory, or select a different directory.
• To accept the default directory, simply click the Next button to continue
       installation.
• To select a different directory:

1. Click the Browse button. A Browse dialog will appear.
2. Select the desired directory and click the OK button. The Browse dialog

will close.
3. Click the Next button on the Directory Screen to continue the installation

process.
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Features
During the installation process you will come to the Features screen. On the Features screen, a check mark next
to a feature means that the feature is selected. All features are selected by default. To deselect a feature, click
once in the check box. The check mark will be removed.

The Features screen contains four check boxes:

Add a Kinnexus shortcut to the desktop Select this feature to create a Kinnexus icon on your
desktop. To open Kinnexus you can simply double-click the icon.

Install Kinnexus mapping (USA only) Select this feature if you wish to locate properties on a
map.

Install Microsoft messaging components Select this feature if you wish to have email function in
Kinnexus. If Microsoft messaging components are already
installed on your computer, this feature will be grayed out.

Make www.kinnexus.com your internet home page        Select this feature if you want your Internet browser to
load the Kinnexus home page every time it is opened.

Note: For a complete set of Kinnexus installation instructions, see Chapter 1.

Local Database Client Installation

Click the Local Database Client Installation option on the Setup screen if you work from a shared database.
Installing the Local Database Client will allow you to replicate data. To install Local Database Client, follow the
instructions below.

1. Click Local Database Client on the Setup screen.
2. Read the licensing agreement. If you agree, click the Yes button at the bottom of agreement. The Microsoft

Data Access Setup screen will appear. If you do not click the Yes button, you will not be able to install
Local Database Client.

3. Click the Continue button. Setup will search for installed components.
4. Click the large icon next to Complete Install all Data Access Components. (Icon resembles a globe in

front of a computer.)
5. Local Database Client will install. Click the OK button when it appears.
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Local Database Server Installation
Click the Local Database Server option on the Setup screen if you do not share a local database, and you want to
be able to download replication files. If you are on a laptop you will need to install Local Database Server. If you
do not travel, and are on a network, only one person on your network needs to install Local Database Server.

Internet Explorer 5.0 Installation
Click the Internet Explorer 5.0 option on the Setup screen if you do not have Internet Explorer 3.0 or greater, and
Internet Explorer 5.0 will be installed on your computer. If you do not have Internet Explorer 3.0 or greater
installed on you computer, some Kinnexus components will not function properly.



Appendix  B - Configuration 103

APPENDIX B: CONFIGURATION

OPTIONS AND FEATURES
Chapter 2 guided you  through a standard configuration with very little explantion of the
various configuration options. This appendix contains descriptions of several configuration
options and shows you when and how to use them.

Welcome to Kinnexus screen
During configuration, a  Welcome to Kinnexus screen will appear. On the Welcome to
Kinnexus screen are several options you can choose from.

Dial into server check box
Select the Dial into server check box on the Welcome to Kinnexus screen if you use a
modem to dial into Kinnexus. If you select this check box, you won’t have to run dial-up
networking when you open the program. Kinnexus will dial up the network for you..

Note: Don’t select this option of you share a computer with several other people, or
if you will be regularly using Kinnexus as a part of a larger Internet session.

RAS Connection and Phone Number fields
In the RAS Connection drop-down field  you select a method for accessing Kinnexus.

• If you are accessing Kinnexus through the Board, click the RAS Connection drop-
down arrow and select Kinnexus from the menu. You will need to type in the correct
dial up phone number in the Phone Number field. If you do not know the correct
phone number, consult your Board Form.

• If you are accessing Kinnexus via the Internet, click the RAS Connection drop-down
menu and select the desired ISP from the menu. The correct phone number will
display in the Phone Number field.

Add and Properties buttons
If you wish to add an ISP or change your dial up networking properties, use the Add and
Properties buttons. Clicking the Add or Properties buttons brings up standard Microsoft
Windows Add and Properties windows. See your Microsoft Widows documentaion for
information on how to add an ISP or change dial-up networking properites.

B
A P P E N D I X
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Download Profiles Screen
During configurarion you will come to the Download Profiles screen. At the Down load
Profiles screen, you need to select on of two radio buttons:  Use Kinnexus online only. Do
not download any information OR Select a profile that describes the database portion
you want to download.

Use online only radio button
Select the Use online only option if you will only be using Kinnexus online. If you select this option you will not
be able to work in Kinnexus while you are offline. Follow the instructions below to configure Kinnexus to run
online only.

1. Select the  Use Kinnexus online only. Do not download any information radio button.
2. Click the Next button. The Online Database screen will appear.
3.  On the Online Database screen will be several radio buttons. Select the radio button that describes the

kind of local database Kinnexus will use on your computer. If you do not know which option best
describes your online database, select the None of the above conditions apply to me radio button.

Local Database radio button options:

I travel with this computer and connect Select this item if you use a laptop.
from different locations like home and work.

There is an office shared network with Select this option if you connect to the server through Local Datatabase
either the main server or an office server. Server on another office computer. If you do not have Local Database
Only select this option if your office Client installed, you will need to install it before you can connect to the
administrator instructs you to. Local Database Server. Don’t select this option unless your office

administrator tells you to.

I am located on a local network with either the This option is used primarily by Board Administrative staff. Don’t select
 main server or an office server. this option unless your office administrator tells you to.

None of the above applies to me. If none of the options on the screen apply to you, or you do not know
which option to choose, select this option.

4. Click the Next button to continue with the configuration process.
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Select a profile
Select the Select a profile that describes the database portion you want to download option if you will be
using Kinnexus offline. If you select this option you will be able to download parts of the Kinnexus database to
work in while you are offline. Follow the instructions below to configure Kinnexus to download parts of the
database.

1. Select the Select a profile that describes the database section you want to download radio button.
2. Click the database section you wish to download from the window below.
3. Click the Next button. The Local Database screen will appear.
4.  On the Local Database screen will be several radio buttons. Select the radio button that describes the

kind of local database Kinnexus will use on your computer. If you do not know which option best
describes your local database, select the None of the above conditions apply to me radio button.

Local Database radio button options:

I travel with this computer and connect Select this item if you use a laptop.
from different locations like home and
work.

There is an office shared network with Select this option if you connect to the server through Local Database
either the main server or an office server. Server on another office computer. If you do not have Local Database
Only select this option if your office Client installed, you will need to install it before you can connect to the
administrator instructs you to. Local Database Server. Don’t select this option unless your office

administrator tells you to.

None of the above conditions applies to me. If none of the options on the screen apply to you, or you do not
know which option to choose, select this option.

5. Click the Next button to continue with the configuration process.
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C
APPENDIX C: LOGON OPTIONS

AND FEATURES
Chapter 3 guided you  through a standard logon. When logging on to Kinnexus, however,
you might want to select different system options, or view certain information. The
following descriptions and instructions identify these optional logon features and show
you how to use them.

Logon Screen

System Selection
If you use more than one system, you can select which system you want to work on by
using the System drop-down menu. The following instructions show you how to select a
system from the System drop-down menu.

1. Click the System drop-down menu. A list of systems that have been configured on
your computer before will display.

2. Click the system you wish to work on.

Systems Button
If you wish to manage or view any of the systems that have been configured on your
computer, click the Systems button. This will open the Systems dialog. Click the Close
button when you are through managing and/or viewing your systems.

Software Button
To view current versions of Kinnexus Software, click the Software button. The Software
dialog will open.  Click the Close button when you are through viewing the software
versions.

A P P E N D I X
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GLOSSARY

Download: The transfer of data from the Kinnexus server to your computer.
Contiguous: Items in a row or next to each other.
Field: One value from the database such as price, area, or street name.
Form: A printout page. The system administrator has created several default forms that you can use. The words

Form, Report, and Print out are used interchangeably.
Listview: A column report, one property per line. Listviews in Kinnexus can also change to be a list of forms.
Home Page: The page you see right after logging in. From the Home Page you can start almost any process.

You can always return to the Home Page by clicking the Home button.
Home Button: Returns you to the Home Page, no matter where you are in the program.
HTTP: Internet acronym for “Hyper Text Transfer Protocol.” This is the format of web pages.
Menu Bar: Contains the  File, Edit, View, etc., menus across the top of the screen.
Next Step Bar: Commands on the bar change according to your location in the program. Only buttons appli-

cable to where you are in the program appear on the bar. Located on the bottom of the screen.
Offline: Means your computer is only retrieving information from your computer, and not the Kinnexus server.
Online: Means your computer is connected to the Kinnexus server, and is retrieving information mainly from

the server and not your computer.
Password: Used in conjunction with your correct username, your password gives you access to the database.

Your username and password are not case sensitive. Your system administrator initially designates your
password, but you can change it any time.

Portfolio: A collection of something -- a collection of your inventory, a collection of your searches, a collection
of mail messages, etc. Clicking on a Portfolio brings up a Listview that shows you the items in the folder.

Replication Profile: The definition of what will be downloaded to your computer. You can join only one
profile at a time. The process of changing profiles is called a cold start.

System Administrator: The computer person designated by your board or MLS to maintain Kinnexus.
Tabs:  Contain different icons that display when you click on the name of the tab. Some of the tabs are Search,

Listing, Internet, and Mail. Located on the left side of the Home Page.
Table: A collection of similar fields in the Kinnexus database. Residential and Common are two examples of

different tables in Kinnexus.
Upload: The process of moving data from your computer to the server. Uploading happens automatically each

time you connect to the server.
URL: Internet acronym for Uniform Resource Locator. In other words, a web page address.
Username: The name that you use to log in to Kinnexus. Your system administrator designates your username.
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